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Preface

BNYCVD01 / 2018506 BNYCVD01 0000214916 A.4 1/2/20, 2:22 PM Released

About the Windows Device Master Manual
The Milnor® Windows Device Master controller consists of software and hardware designed to
control conveyor belts and other devices according to instructions from a Milnor® Miltrac™ sys-
tem, and to communicate the contents and actions of these devices to the Miltrac™ controller.
The controlled belts are usually present, but may also exist only in the logic of the controller
(phantom devices). In the context of this manual, a device is one or more physical or phantom
belts operated with a single set of Miltrac™ commands.

.1 Scope
BNYCVD01.C02 0000214914 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This manual provides instructions on configuring, monitoring, and troubleshooting the Milnor®
Windows Device Master belt controller. Refer to additional documentation provided with this
controller for additional information. Replacement documentation is available from the Milnor®
parts department.

.2 Identifying the Software Version
BNYCVD01.C03 0000214913 A.3 B.2 A.4 1/2/20, 2:22 PM Released

Have the version number of your Windows Device Master controller software available any time
you call for technical assistance. This number is visible in the lower right corner of the main De-
vice Master screen. Additional information is available by selecting the Help topic from the main
Device Master menu, then selecting System Information. The Milnor® Software tab (Figure 1,
page 2) shows a list of Milnor® software installed on this computer, as well as all available soft-
ware versions.
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Figure 1. Milnor® Software Tab

.3 Trademarks
BNUUUU02.R01 0000158093 B.2 A.4 E.2 3/3/21, 9:47 AM Released

These words are trademarks of Pellerin Milnor® Corporation and other entities:
Table 1. Trademarks
AutoSpot™ GreenFlex™ MilMetrix® PulseFlow®

CBW® GearTrace™ MilTouch™ RAM Command™
Drynet™ GreenTurn™ MilTouch-EX™ RecircONE®

E-P Express® Hydro-cushion™ MILRAIL™ RinSave®
E-P OneTouch® Mentor® Miltrac™ SmoothCoil™
E-P Plus® Mildata® PBW™ Staph Guard®
Gear Guardian® Milnor®

BNUUUT01 / 2018466 BNUUUT01 B.3

How to Contact Milnor®
Your authorized Milnor® dealer can assist you with your Milnor® machine and knows about the
local conditions that may be pertinent to the installation, use, or maintenance of the machine.
Contact your dealer first. For assistance from the Milnor® factory, refer to Table 2, page 3 for
contact information.
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Table 2. Pellerin Milnor® Corporation Contact Information
Purpose Department Telephone FAX E-mail/Web site

Order or ask about
replacement parts

Parts 504–712–7775
or
800–299–1500

504–469–9777 parts@milnor.com

Get advice on instal-
ling, servicing, or
using

Customer Serv-
ice/ Technical
Support

504–712–7780 504–469–9777 service@milnor.com
www.milnor.com
(Customer Service)

Learn about, request,
or enroll in Milnor®
service seminars

Training 504–712–7716 504–469–9777 training@milnor.com

Determine warranty
eligibility or claim
status

Warranty
Administration

504–712–7735 504–469–9777 service@milnor.com
(Attention: Warranty)

Ask about, comment
on, or report an error
in equipment
manuals

Technical
Publications

504–712–7636 504–469–1849 techpub@milnor.com

European contacts Milnor®
International

+ 32 2 720 5822 — milnor@milnor.be

Ask about the ship-
ping weight of your
machine before it ar-
rives at your facility

Logistics
Department

504–712–7686 504–471–0273 —

Pellerin Milnor Corporation
Post Office Box 400
Kenner, LA 70063-0400

Telephone: 504-467-9591
http://www.milnor.com
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1 Operation

BNYCVO01 / 2019033 BNYCVO01 0000215035 A.8 1/2/20, 2:22 PM Released

1.1 The Normal Start-up Sequence
BNYCVO01.C01 0000215042 B.2 A.7 A.8 1/2/20, 2:22 PM Released

1. On system start-up theMain screen—shown in Figure 2:Main Display, page 5 —is dis-
played while the Device Master computer tries to establish communications with the process-
or board. If the computer is unable to communicate with the processor, an error window is
displayed, as shown in Figure 3: Communications Failure Error Window, page 5 . The oper-
ator has the option to Abort, Retry, or Ignore the failure.
• Abort—terminates the Device Master application
• Retry—repeats the attempt to establish communications
• Ignore—places the Device Master application in simulator mode, which allows the user

to utilize the Device Master application without a physical connection to the controller.
2. If the communication is successful, the operating system initially invokesManual mode, de-

scribed in Section 5.2 : Manual Operation, page 67. TheManual mode window displays the
status of all inputs and outputs, and may be used to manually turn all outputs on or off.

3. The Initialize Devices form (Figure 4: Initialize DevicesWindow, page 5 ) is automatically
displayed when theManual mode window is closed. Each device (other than the Allied Dry-
er device) runs its belt in a pre-established direction for initialization until either the applica-
ble photoeye is blocked or the configured Clear Belt Time expires (described in Section
3.1.2.3.22.3 : Clear Belt Time, page 53). This form provides a visual indication of the status
of each device during initialization.

4. When all devices are initialized, a message box (Figure 5: Is Device Loaded?Window, page
5 ) is displayed sequentially for each device where the photoeye was blocked to confirm
whether or not the device is loaded. For each loaded device, a Data Entry form (Figure 6:
Data EntryWindow, page 6 ) is displayed to provide for cake data entry. Data is uploaded to
the processor when the Data Entry form is closed.

5. Following initialization, control returns to theMain screen. From theMain menu, the user
has the following options: File, View, Admin Logon, and Help. Each of these options, as
well as others that are available only to system administrators, is described in Section 1.2 :
Using the Menu System, page 6.

6. The message box shown in Figure 7: Processor Board Reset Error Window, page 6 is dis-
played when a problem occurs which causes the processor board to reset. Click OK to re-ini-
tialize the control toManual mode.
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Figure 2. Main Display

Figure 3. Communications Failure Error Window

Figure 4. Initialize Devices Window

Figure 5. Is Device Loaded? Window

Operation
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Figure 6. Data Entry Window

Figure 7. Processor Board Reset Error Window

BNYCVO02 / 2019033 BNYCVO02 0000215034 A.6 1/2/20, 2:22 PM Released

1.2 Using the Menu System
BNYCVO02.C01 0000215072 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The user interface of the Milnor® Windows Device Master controller system uses the hierarchical
menu system common to the Microsoft® Windows® operating system.
When the Device Master system is operating, it can be in one of two modes:
• The administrator level allows the user complete access to all configuration and operating

data.
• The operator level allows the user access to features necessary to operate the system, while

restricting access to configuration data and system accumulators.
The appearance of theMain menu—shown in Figure 8, page 7—changes to reflect the additional
functions available to the system administrator. This document describes the function of each
menu item at both the Administrator and Operator levels, and provides references to detailed
information about the options available in each menu selection.

Operation
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Figure 8. Main Menus
Administrator Main Menu

Operator Main Menu

Any menu selection which is used to modify configuration data cannot be implemented while the
Device Master controller is in operation. In those cases, the user will first be prompted by a mes-
sage box, as shown in Figure 9, page 7, to disable the three wire circuit before access to that se-
lection is allowed.
Figure 9. Three Wire Message Box

1.2.1 File Menu
BNYCVO02.C02 0000215087 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + F from the main window selects the File menu item (Figure 10,

page 7). The File menu item can also be selected from the main
menu by clicking on the File menu item. The File menu item is
available to all users.

Figure 10. Device Master File Menu

Operation
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1.2.1.1 Backup
BNYCVO02.C03 0000215085 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
B from the File menu, this keystroke (or clicking on the Backup

menu item) displays the Backup Configuration form (Figure 11,
page 8), which allows the user to select the desired destination
drive to which the backup will be saved. Network drives are avail-
able if the Include Network Connections option is checked.
Clicking on the Backup Configure button begins the process of
saving data from the computer to the selected destination drive.
Backup creates three files on the destination drive under the di-
rectory \computername\DevMas, where computername is
the name associated with the Device Master computer:

• devmas.reg—contains all system and device configuration data
• names.mdb—contains all user-defined names data, and
• language.mdb—contains all non-English language translation data.
As these files are written to the destination drive, the status of the copy is displayed in the text
box at the bottom of the Backup Configuration form. Click on the Cancel button to close the
Backup Configuration form when the copy process is complete.
Figure 11. Backup Configuration Form
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1.2.1.2 Restore
BNYCVO02.C04 0000215083 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
R from the File menu, this keystroke (or clicking on the Restore

menu item) displays the Restore Configuration form (Figure 12,
page 9), which allows the user to select the desired source drive
from which the backup will be retrieved. Network drives are
available if the Include Network Connections option is checked.
Clicking on the Restore Configure button begins the process of
restoring data from the selected source drive to the computer. Re-
store overwrites all system, device, and page configuration data
with the information from the devmas.reg file, and copies the
names.mdb and language.mdb files to the hard drive of the
computer. Existing files named names.mdb or language.
mdb are overwritten. Restore only looks for those source files
stored on the selected source drive under the directory \com-
putername\DevMas, where computername is the name as-
sociated with the Device Master computer.

As these files are read from the source drive, the status of the copy is displayed in the text box at
the bottom of the Restore Configuration form. Click on the Cancel button to close the Restore
Configuration form when the copy process is complete.
The Restore Configuration menu selection is not accessible if the three wire circuit is enabled.
In this case, the user will be prompted to disable the three wire circuit before proceeding.
Figure 12. Restore Configuration Form
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1.2.1.3 Export Configuration
BNYCVO02.C05 0000215082 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
E from the File menu, this keystroke (or holding the mouse cursor

over the Export Config menu item) displays the sub-menu item
Text File as shown in Figure 13, page 10. Clicking on Text File
causes the configuration data to be written to C:\DevMasCon-
fig.txt. If a file by this name already exists, it will be over-
written. Once created, the file automatically opens in Windows
Notepad for viewing and/or printing as shown in Figure 14, page
10.

Figure 13. Export Configuration Menu Item

Figure 14. Exported Configuration in Windows Notepad
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1.2.1.4 Exit
BNYCVO02.C06 0000215079 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
X from the File menu, this keystroke (or clicking on the Exit menu

item) closes the Device Master application. The Exit menu item is
accessible only when the user is logged on as an administrator

1.2.2 View Menu
BNYCVO02.C07 0000215110 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + V from the main window selects the View menu item. The View

menu item can also be selected from the main menu by clicking
on the View menu item. The View menu item is available to all
users.

Figure 15. Device Master View Menu

1.2.2.1 Inputs and Outputs
BNYCVO02.C08 0000215108 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
I from the View menu, this keystroke (or clicking on the Inputs

and Outputs menu item) accesses the Inputs and Outputs page.
This page is also available from the Device Master main page by
pressing Ctrl + I. Refer to Section 1.4 : Viewing Electronic Inputs
and Outputs, page 25 for an explanation of the Inputs and Out-
puts page.

1.2.2.2 Cake Page
BNYCVO02.C09 0000215107 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
C from the View menu, this keystroke (or clicking on the Cake

Page menu item) accesses the Cake page. This page is also avail-
able from the Device Master main page by pressing Ctrl + C. Re-
fer to Section 1.3.1 : Cake Page Description, page 19 for an
explanation of the Cake page.

Operation
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1.2.2.3 State Page
BNYCVO02.C10 0000215106 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
S from the View menu, this keystroke (or clicking on the State Page

menu item) accesses the State page. This page is also available
from the Device Master main page by pressing Ctrl + S. Refer to
Section 1.3.2 : State Page Description, page 22 for an explanation
of the State page.

1.2.2.4 Manual Page
BNYCVO02.C11 0000215105 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
M from the View menu, this keystroke (or clicking on theManual

Page menu item) accesses theManual page. This page is also
available from the Device Master main page by pressing Ctrl +
M. Automatic operation of all Device Master-controlled devices
is suspended when theManual Page menu item is selected. Refer
to Section 5.2 : Manual Operation, page 67 for an explanation of
theManual page.

1.2.3 Admin Logon/Logout Menu
BNYCVO02.C13 0000215193 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + A from the Operator main window invokes the Admin Logon win-

dow. The Admin Logon window can also be invoked from the
main menu by clicking on the Admin Logon menu item.
The Admin Logon window is used to gain access to the Adminis-
trator menu. When the Admin Logon menu item is selected, the
user is prompted for a password (Figure 16, page 13). By entering
a valid password, the user is provided access to the Administra-
tor Main menu.

TIP: An encrypted representation of the administrator password is shown on theMain
display, below the Milnor® logo. This information can be used to recover a lost password.

Operation
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Figure 16. Device Master Administrator Logon Menu Selection

Display or Action Explanation
Alt + A from the Administrator main window invokes the Admin Log-

out menu item. Admin Logout can also be invoked from the
main menu by clicking on the Admin Logout menu item.
The Admin Logout menu item returns the user to the Operator
Main menu.

1.2.4 Initialize Menu: Clear Accumulators
BNYCVO02.C14 0000215191 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + I from the main window selects the Initialize menu item. The Initi-

alize menu item can also be selected from the main menu by
clicking on the Initialize menu item. This item is available only
when the user is logged is as an administrator.

C from the Initialize menu, shown in Figure 17, page 13, this key-
stroke (or clicking on the Clear Accumulators menu item) clears
the controller accumulators. The Device Master controller main-
tains two accumulators: the Empty timer and the Loaded timer,
which are both displayed on the State Page (see Section 1.3.2 :
State Page Description, page 22).

Figure 17. Device Master Initialize Menu

1.2.5 Options Menu: Clear Memory
BNYCVO02.C12 0000215189 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + O from the main window selects the Options menu item (Figure 18,

page 14). The Options menu item can also be selected from the
main menu by clicking on the Options menu item. This item is
available only when the user is logged is as an administrator.

Operation
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Figure 18. Device Master Options Menu

1.2.5.1 Clear Memory
BNYCVO02.C15 0000215187 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
C from the Options menu, this keystroke (or clicking on the Clear

memory menu item) prompts the user to verify the Clear Memo-
ry selection (Figure 19, page 14). Click the Yes button to clear the
controller memory. This action resets all system, device, and page
configuration data to its default values, but does not affect the
user-defined names data.

Figure 19. Clear Memory Confirmation Window

The Clear Memory menu selection is not accessible if the three wire circuit is enabled. In this
case, the user will be prompted to disable the three wire circuit before proceeding.

1.2.5.2 Change Admin Password
BNYCVO02.C16 0000215244 A.3 B.2 A.6 1/2/20, 2:22 PM Released

From the Options menu, clicking on Change Admin Password opens the Change Current
Password window (Figure 20, page 14) to allow the user to replace the existing administrator
password with a new password of three to 10 characters for access to the Administrator Main
menu. Password entry is case-sensitive.
Figure 20. Change Current Password window
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1.2.5.3 Event Log
BNYCVO02.C17 0000215242 B.2 A.4 A.6 1/2/20, 2:22 PM Released

From the Options menu, clicking on the Event Log menu item enables or disables the Event
Log feature, depending on its current state. A check mark next to the Event Log menu item indi-
cates that the feature is currently enabled (Figure 21, page 15).
Figure 21. Event Log Enabled

When the Event Log feaure is enabled, Device Master controller will add an entry to the event
log file, C:\Program Files\Milnor\DevMas\DevMas.log, which includes a date and
time stamp, whenever a specific pre-established event occurs (Table 3, page 15). The Event Log
feature is mainly for diagnostic purposes, and should not normally be enabled.
Table 3. Logged Events
Event Log enabled Administrator logged on
Event log disabled Administrator logged out
3-Wire disabled Diagnostics enabled
3-Wire enabled Diagnostics disabled
3-Wire fault Device Master Controller unloaded
Comm Stats reset

1.2.6 Configure Menu
BNYCVO02.C18 0000215240 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + C from the main window selects the Configure menu item. The

Configure menu item can also be selected from the main menu
by clicking on the Configure menu item. This item is available
only when the user is logged is as an administrator. All configure
decisions are described in Section 3.1 : Configuring the Device
Master Controller, page 41.

Figure 22. Device Master Configure Menu
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1.2.6.1 System
BNYCVO02.C19 0000215239 B.2 A.5 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
S from the Configure menu, this keystroke (or clicking on the Sys-

tem menu item) accesses the System Configuration. The System
Configuration menu selection is not accessible if the three wire
circuit is enabled. In this case, the user will be prompted to disable
the three wire circuit before proceeding. Refer to Section 3.1.1 :
System Configuration, page 41 for an explanation of System
Configuration.

1.2.6.2 Devices
BNYCVO02.C20 0000215238 B.2 A.5 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
D from the Configure menu, this keystroke (or clicking on the Devi-

ces menu item) accesses the Device Configuration screen. The
Device Configuration menu selection is not accessible if the
three wire circuit is enabled. In this case, the user will be
prompted to disable the three wire circuit before proceeding. Re-
fer to Section 3.1.2 : Device Configuration, page 46 for an explan-
ation of Device Configuration.

1.2.6.3 Pages
BNYCVO02.C21 0000215237 B.2 A.5 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
P from the Configure menu, this keystroke (or clicking on the Pa-

ges menu item) accesses the Page Configuration screen. Refer to
Section 3.1.4 : Pages Configuration, page 56 for an explanation of
Page Configuration.

1.2.7 Names: Add, Modify, or Delete a Name
BNYCVO02.C22 0000215273 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + N from the main window accesses the Names window, as shown in

Figure 23, page 17. The Names window can also be selected from
the main menu by clicking on the Names menu item. This item is
available only when the user is logged is as an administrator.
The Names window allows an administrator to add, modify, or
delete the user-defined names associated with the data fields dis-
played on the Cake page (Formula, Extract code, Dry code, Desti-
nation, Customer, and Goods code).

Operation
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Figure 23. Device Master Names Window

1.2.8 Help Menu
BNYCVO02.C23 0000215319 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
Alt + H from the main window selects the Help menu item (Figure 24,

page 17). The Help menu item can also be selected from the main
menu by clicking on the Help menu item. This item is available to
all users.

Figure 24. Device Master Help Menu

1.2.8.1 System Information
BNYCVO02.C24 0000215317 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
S from the Help menu, this keystroke (or clicking on the System

Information menu item) accesses the About System window,
shown in Figure 25, page 18. The About System window com-
prises several tabbed pages which display various information
about the computer running the Device Master application, in-
cluding the Device Master application software and machine soft-
ware versions. All of this information can be saved to a text file
from the File menu in the window, if necessary.
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Figure 25. Typical About System Windows

1.2.8.2 Diagnostics
BNYCVO02.C25 0000215315 A.3 B.2 A.6 1/2/20, 2:22 PM Released

Display or Action Explanation
D from the Help menu, this keystroke (or clicking on the Diagnos-

tics menu item) enables or disables the Diagnostics feature de-
pending on its current state. A check mark next to the Diagnostics
menu item indicates that the feature is currently enabled (Figure
26, page 18). When the Diagnostics feaure is enabled, several ac-
cumulators, which track communication failures between the PC
and processor board, are displayed in the lower left-hand corner
of theMain page. A Clear button is provided to allow the user to
reset the accumulators. The Diagnostic feature is used as an aid in
troubleshooting communication problems, and should not nor-
mally be enabled.

Figure 26. Device Master Diagnostics
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BNYCVO03 / 2019033 BNYCVO03 0000215123 A.6 1/2/20, 2:22 PM Released

1.3 How to View Cake Data and Device Status
BNYCVO03.C01 0000215122 B.2 A.5 A.6 1/2/20, 2:22 PM Released

All monitoring of normal Device Master operation is done by observing the Cake Page and the
State Page while the system is operating. The Cake Page displays cake data for each Device
Master-controlled device, while the State Page displays the Miltrac™ status for each Device
Master-controlled device.
Display or Action Explanation

Ctrl + C from the Device Master main window, invokes the Cake Page
display. This display can also be accessed from the View menu,
shown in Figure 27, page 19.

Ctrl + S from the Device Master main window, invokes the State Page
display. This display can also be accessed from the View menu,
shown in Figure 27, page 19.

Exit closes the Cake Page or State Page display and returns to the De-
vice Master main window.

Figure 27. Displaying the Cake and State Pages
Menu Selection Screen Legend

A...Cake Page menu item
B...State Page menu item

1.3.1 Cake Page Description
BNYCVO03.C02 0000215471 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The Cake Page, shown in Figure 28, page 20, provides batch data about the goods on each device
controlled by Device Master. An administrator specifies which data to display on this page from
the Configure/Pages menu item of the main Device Master screen, as explained in Section 3.1.4
: Pages Configuration, page 56 and Figure 39: Typical Pages Configuration, page 57 . Up to seven
types of data can be displayed simultaneously for each device.
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Figure 28. Cake Page
Overview and Detail

Legend
A...Typical standard device window
B...Typical Linear Costa device window
C... Batch data categories
D...Time device has contained this batch
E...Device number and name

1.3.1.1 Device Number and Name
BNYCVO03.C03 0000215469 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The first Device Master device is designated device number 00, and subsequent devices are
numbered sequentially to the maximum device number of 15 (16 devices).
An administrator for the Device Master controller can assign a descriptive Device Name to each
device during configuration. Refer to Section 3.1.2.1 : Device Name, page 47 for information on
configuring a device name. On the Device Master Cake Page, the device number and name ap-
pear in the upper left of the box associated with the device.
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1.3.1.2 Batch Data
BNYCVO03.C04 0000215468 B.2 A.4 A.6 1/2/20, 2:22 PM Released

Batch data is information associated with each load of goods (batch). Most batch data describes
how goods should be routed and processed as they flow through the laundry, while other fields
are more useful for laundry accounting. User-defined names can be programmed as a conven-
ience in identifying the various batch codes. Refer to Section 1.2.7 : Names: Add, Modify, or De-
lete a Name, page 16 for an explanation on how to program names for batch codes.
The Formula field contains the wash formula number for processing the load. This three digit
number between 000 and 999 corresponds to the formula number used in the washing device.
Formula names entered via the Names menu appear beside the formula number.
The Extract code is used by the extraction device when processing the batch. Extract codes are
three digits from 000 to 255, allowing selection of one of the 16 different formulas in presses and
centrifugal extractors. Extract code names entered via the Names menu appear beside the extract
code number.
The Dry code is the formula used by the dryer for processing the goods. Valid dry codes are 000
through 255. Dry code names entered via the Names menu appear beside the dry code number.
The Destination field is used to specify where to route the goods after discharge from the dryer.
Valid destination codes are 000 through 255. Destination names entered via the Names menu ap-
pear beside the destination code number.
The Customer field is often used in laundry accounting to track the number of batches processed
for each customer. Valid customer numbers are 000 through 999. Customer names entered via the
Names menu appear beside the customer code number.
Goods codes are used by older Milnor® CBW® systems with Miltron controllers. This code iden-
tifies a subset of a general class of goods. All batches conforming to the general class are proc-
essed using the same wash formula, but each specific goods code within that class causes
variations in processing, increasing the number of available wash formulas. While some systems
may use goods codes to control post-wash processing, these codes are primarily used for account-
ing purposes. Valid goods codes are 000 through 999. Goods code names entered via the Names
menu appear beside the goods code number.
TheWeight field displays the weight of the goods when they entered the system. Depending on
the loading system, the goods may be weighed electronically, or the weight may be entered man-
ually by an operator. The units name (LBS or KG) that appears next to the weight value corre-
sponds to the configuration for weight units as described in Section 3.1.1.1.1.7 : Weight Units,
page 43.
Cake Number is a value between 000 and 255 generated sequentially by the Milnor® CBW®

controller and passed by the Miltrac™ controller. This number identifies the order in which the
cakes entered the system
The Single Cake attribute designates a load of goods which must be processed separately. The
Single Cake field can have a value of 1 (Single Cake=Yes) or 0 (Single Cake=No). Batches that
are not denoted as single cakes (Single Cake = No) may be combined with other cakes if all com-
patibility conditions are met.
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1.3.1.3 Device Loaded/Empty Timer
BNYCVO03.C05 0000215467 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The timer at the bottom of each device box displays how long (mm:ss) the current batch has been
in this device (the Loaded timer), or how much time has elapsed since the device discharged its
last batch (the Empty timer). This timer resets each time the device discharges a cake or receives
a cake. The State Page (described in Section 1.3.2 : State Page Description, page 22) displays cu-
mulative empty and loaded times for each device. The Device Loaded/Empty Timer is not ap-
plicable to the multiple-cake Linear Costa, and is not shown for that device.

1.3.1.4 Linear Costa Device
BNYCVO03.C06 0000215466 B.2 A.4 A.6 1/2/20, 2:22 PM Released

For a Linear Costa device, batch data numbers are shown without names in an overview presenta-
tion, by default, to display the cake data for all positions. Across the bottom edge of the device
box are eight small control buttons numbered 0 through 7, and one larger control button labelled
Overview, which allow the user to alternate between the overview and a detail view, with names,
of any one cake position. The current display is identified by a label in the upper right corner of
the device box.

1.3.2 State Page Description
BNYCVO03.C07 0000215555 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The State Page, shown in Figure 28: Cake Page, page 20 , displays the Miltrac™ communica-
tions for each Device Master-controlled device. This page is used to monitor Miltrac™ transfers
involving devices controlled by Device Master. A typical State Page is shown in Figure 29, page
23, along with a detail of one Linear Costa device and one device other than a Linear Costa.
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Figure 29. State Page
Overview and Detail

Legend
A...Typical standard device window
B...Typical Linear Costa device window
C...Receive state
D...Receive command
E...Transfer state
F...Transfer command
G...Device state and timers

1.3.2.1 Device Number and Name
BNYCVO03.C08 0000215553 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The first Device Master device is designated device number 00, and subsequent devices are
numbered sequentially to the maximum device number of 15 (16 devices).
An administrator for the Device Master controller can assign a descriptive Device Name to each
device during configuration. Refer to Section 3.1.2.1 : Device Name, page 47 for information on
configuring a device name. On the Device Master State Page, the device number and name ap-
pear in the center top of the box associated with the device.
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1.3.2.2 Receive State
BNYCVO03.C09 0000215552 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The Receive State field displays the loading status sent by the device to the Miltrac™ controller.
This field applies to Miltrac™ systems only. These are the valid receive states:
• Can't Receive
• Want to Receive
• Ready to Receive
• Done Receiving or Done Receiving *

TIP: The * indicates that this device cannot accept another cake.

1.3.2.3 Receive Command
BNYCVO03.C10 0000215551 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The Receive Command field displays the command issued by Miltrac™ to the device for the load-
ing process. This field applies to Miltrac™ systems only. These receive commands are valid:
• Do Nothing
• Get Ready, Get Ready Left, or Get Ready Right—see below note
• Start
• You're Finished or You're Finished *

NOTE: The Get Ready, Get Ready Left, and Get Ready Right commands apply to
moveable devices and depend on the X-Y coordinates of the device as configured in
Miltrac™.
TIP: The * implies that no more cakes are available for transfer.

1.3.2.4 Transfer State
BNYCVO03.C11 0000215550 B.2 A.4 A.6 1/2/20, 2:22 PM Released

The Transfer State is the discharge status sent by the device to the Miltrac™ controller for dis-
charging when configured for Miltrac™ discharge only. There are five valid discharge states:
• Can't Transfer
• Want to Transfer
• Ready to Transfer
• Done Transferring or Done Transferring *

TIP: The * implies that this device cannot discharge another cake.
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1.3.2.5 Transfer Command
BNYCVO03.C12 0000215549 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The Transfer Command field displays Miltrac™ commands to the device for the discharging
process when configured for Miltrac™ discharge. Valid transfer commands are the same as the
receive commands, listed in Section 1.3.2.3 : Receive Command, page 24.

1.3.2.6 Device State and Timers
BNYCVO03.C13 0000215548 A.3 B.2 A.6 1/2/20, 2:22 PM Released

1.3.2.6.1 State
BNYCVO03.C14 0000215547 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The State displayed in the lower part of each device box is a diagnostic tool which identifies the
software state of the device for use in troubleshooting. Each Device Master device has from five
to nine valid states, depending on the device type. A Linear Costa device displays a sepatate re-
ceive state (R-State) and discharge state (D-State).

1.3.2.6.2 Empty Timer
BNYCVO03.C15 0000215546 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The Empty timer in the lower part of each device box maintains a cumulative total of the time
the device did not have a load. This timer displays the time spent waiting on the upstream device
(s) for loading. The Empty timer is not applicable to the multiple-cake Linear Costa, and is not
shown for that device.

1.3.2.6.3 Loaded Timer
BNYCVO03.C16 0000215578 A.3 B.2 A.6 1/2/20, 2:22 PM Released

The Loaded timer in the lower part of each device box maintains a cumulative total of the time
the device was loaded. This timer displays the time spent waiting on the downstream device(s)
for discharging. The Loaded timer is not applicable to the multiple-cake Linear Costa, and is not
shown for that device.

BNYCVO04 / 2019033 BNYCVO04 0000215153 A.7 1/2/20, 2:22 PM Released

1.4 Viewing Electronic Inputs and Outputs
BNYCVO04.C01 0000215152 B.2 A.5 A.7 1/2/20, 2:22 PM Released

The View/Inputs and Outputs menu selection described here allows the operator to view inputs
and outputs for each device while the system is operating automatically. The View/Manual
Page menu selection described in Section 5.2 : Manual Operation, page 67 allows the operator to
view inputs and turn on outputs for testing.
Display or Action Explanation

Ctrl + I from the Device Master main window, invokes the Inputs and
Outputs display. This mode can also be accessed from the View
menu, as shown in Figure 30, page 26.

Exit closes the Inputs and Outputs screen and returns to the Device
Master main window.
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Figure 30. Menu Selection

A typical Device Inputs and Outputs screen is illustrated in Figure 31, page 26. On this screen,
green lights indicate inputs and red lights indicate outputs. The light is illuminated (on) when its
input is grounded, or when its output is actuated. Signals displayed are those that are applicable
to the selected device. Signal names are grayed if the device has not been configured for that par-
ticular option or if the signal is not used.

TIP: When the mouse pointer is positioned over a valid input or output signal, the board
address and connection are displayed.

Figure 31. Typical Inputs/Outputs Display

1.4.1 Selecting a Device to Test
BNYCVO04.C02 0000215653 A.3 B.2 A.7 1/2/20, 2:22 PM Released

Figure 32, page 27 shows an example of the Select Device drop-down list. Place the mouse cur-
sor over the arrow and click the left button once to display a list of all devices configured on this
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controller. Highlight the desired device and click the mouse again to display the screen for the de-
vice. To view another screen, select another device from the list.
Figure 32. Select Device Region of the Inputs and Outputs Screen

1.4.2 Direct Inputs
BNYCVO04.C03 0000215650 A.3 B.2 A.7 1/2/20, 2:22 PM Released

Direct inputs are signals to the Device Master controller which are connected directly to the pro-
cessor board rather than a peripheral board (e.g., an 8-input/16-output board).

1.4.2.1 Program Key
BNYCVO04.C04 0000215649 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The Program Key input on the Device Master processor board is permanently grounded (always
made), to facilitate changes to program memory on the processor board from the Device Master
computer.

1.4.2.2 Signal Cancel
BNYCVO04.C05 0000215648 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The Signal Cancel input is made directly from the Signal Cancel button on the control panel to
the Device Master processor board; the wire from the button attaches directly to a connector on
the processor board. While there may be connectors in the wire where it passes through control
box walls, etc., there are no electronic components (relays, fuses, etc.) along the way.

1.4.3 System I/O
BNYCVO04.C06 0000215647 A.3 B.2 A.7 1/2/20, 2:22 PM Released

System inputs and outputs are general inputs and outputs that apply to the Device Master system,
rather than a particular device.

1.4.3.1 3-wire
BNYCVO04.C07 0000215646 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The three-wire input is active when the three-wire circuit is energized to supply 120VAC control
power to all Device Master-controlled devices. The three-wire circuit is energized by pressing the
Start button ( ) on the operator control panel.
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1.4.3.2 Signal
BNYCVO04.C08 0000215645 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The signal output controls the operator alarm. When the signal output is actuated, the alarm
sounds and the signal light on the control panel illuminates.

1.4.4 Monitoring Inputs
BNYCVO04.C09 0000215676 B.2 A.4 A.7 1/2/20, 2:22 PM Released

When the Inputs and Outputs screen is displayed, all inputs that are grounded appear illumi-
nated, and all inputs that are not grounded or are not used appear dark. The I/O Legend region in
the upper right corner of theManual Operation screen shows inputs in both states.
This screen is commonly used to verify that inputs to Device Master-controlled devices are func-
tioning properly. As contacts and photoeyes actuate at the remote device, the appropriate light on
the Device MasterManual Operation screen illuminates. For example (see Figure 31: Typical
Inputs/Outputs Display, page 26 ), when the discharge end eye of the belt is blocked, the For-
ward Eye input light is normally on.

1.4.5 Monitoring Outputs
BNYCVO04.C10 0000215675 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The Inputs and Outputs screen allows the user to observe the operation of outputs while the sys-
tem is operating. Outputs that are actuated appear illuminated, while outputs that are turned off
appear dark. The I/O Legend region in the upper right corner of this screen shows example out-
puts in both states.
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2 Devices

BNYCVF01 / 2019033 BNYCVF01 0000215284 A.8 1/2/20, 2:22 PM Released

2.1 Device Type 0: Dryer Unloader
BNYCVF01.C01 0000215283 B.2 A.5 A.8 1/2/20, 2:22 PM Released

The Dryer Unloader device is a Device Master-controlled conveyor belt which receives and
stores goods discharged from one or more Milnor® dryers. The Dryer Unloader can only receive
goods from a Milnor® Miltrac™-controlled device, but can discharge to either a Miltrac™ or
non-Miltrac™ (allied) device. Photoeyes on both ends of the Dryer Unloader belt allow it to run
in either direction.
Dryer Unloader may be configured to pass allied data and/or allied weight. It may also be config-
ured to extend if so equipped, and/or to work with a sequencing belt.

2.1.1 For Version 21106 and Later of Software WUDEVMASF
BNYCVF01.C02 0000215722 A.3 B.2 A.8 1/2/20, 2:22 PM Released

• When loading a Miltrac™-controlled device, the Dryer Unloader belt runs in the direction
specified by the Direction for Load Device decision in the receiving device.

• When receiving from a Miltrac™-controlled device, the Dryer Unloader belt runs in the di-
rection specified by the Discharge Direction decision in the loading device.

2.1.2 For Software Versions Before 21106
BNYCVF01.C03 0000215721 A.3 B.2 A.8 1/2/20, 2:22 PM Released

For Miltrac™ transfers, the Dryer Unloader uses the Get Ready command from Miltrac™ to de-
termine which direction to run its belt. This command has three variations:
• The Get Ready command applies if Dryer Unloader has the same Y coordinate as the mating

device.
• The Get Ready Left command applies if Dryer Unloader has a lower Y coordinate than the

mating device.
• The Get Ready Right command applies if Dryer Unloader has a higher Y coordinate than

the mating device.
Dryer Unloader must be configured in Miltrac™ as a movable device if its Y coordinate is differ-
ent than the Y coordinate of either the device that discharges to it or the device that receives from
it.

2.1.3 Receiving
BNYCVF01.C04 0000215720 B.2 A.4 A.8 1/2/20, 2:22 PM Released

The Dryer Unloader can only be loaded by a Miltrac™-controlled device.
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1. Device Master waits for the Load Allowed input before telling Miltrac™ that the Dryer Un-
loader wants to receive a load.

2. This step depends on the software version:
• For version 21106 and later of software WUDEVMASF, the belt direction is determined

by the Direction for Receiving Device decision in the loading device.
• For software versions before 21106, Miltrac™ tells the Dryer Unloader which direction

to run the belt. The Dryer Unloader belt runs forward if Miltrac™ commands either Get
Ready or Get Ready Left. The belt runs in reverse if Miltrac™ commands the Dryer Un-
loader to Get Ready Right.

3. When Miltrac™ issues the command to Start Receiving, Dryer Unloader waits for the time
specified by Delay Before Run before running the belt.

4. The Dryer Unloader belt runs while the discharging dryer unloads, spreading the goods
along the length of the belt.

5. The belt stops when the goods actuate the photoeye at the end of the belt.
6. If the photoeye is not actuated within the time specified by Clear Belt Time, the Device Mas-

ter controller signals an error (01 NO TRANSFER).

7. If necessary, press Signal Cancel ( ) on the switch panel to clear this error and initialize
the belt.

2.1.4 Discharging
BNYCVF01.C05 0000215719 B.2 A.4 A.8 1/2/20, 2:22 PM Released

1. Once loaded, the belt is ready to discharge.
• For Miltrac™ discharge, Device Master waits for the Discharge Allowed input before

telling Miltrac™ that the Dryer Unloader wants to discharge a load. Miltrac™ tells the
Dryer Unloader which direction to run the belt and when to start the discharge.
– For version 21106 and later of software WUDEVMASF, the belt direction is deter-

mined by the Direction for Load Device decision in the device that will receive the
load.

– For software versions before 21106, the belt runs forward if Miltrac™ commands the
Dryer Unloader to Get Ready or to Get Ready Right. The belt runs in reverse if
Miltrac™ commands Get Ready Left.

• For discharge to an allied device, discharge begins as soon as the Dryer Unloader sees the
Discharge Allowed input. The Dryer Unloader belt runs in the direction specified by the
Discharge Direction decision for this device in the Configure/Devices menu selection.

2. The belt stops and the system resets for another load after Clear Belt Time expires and the
discharge end photoeye clears.
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BNYCVF02 / 2019033 BNYCVF02 0000215294 A.7 1/2/20, 2:22 PM Released

2.2 Device Type 1: Storage Belt
BNYCVF02.C01 0000215293 B.2 A.5 A.7 1/2/20, 2:22 PM Released

The Storage Belt device is a Device Master-controlled conveyor belt which receives and stores
goods discharged from a Milnor® device. A Storage Belt can only receive goods from a Milnor®
Miltrac™-controlled device, but can discharge to either a Miltrac™ or non-Miltrac™ (allied) de-
vice. The Storage Belt has photoeyes on each end, but runs in only one direction whether receiv-
ing or discharging. It may be configured for allied data passing, allied weight passing, and/or
allied compatibility. The Storage Belt may also be configured to extend and/or work with a com-
pacting belt.

2.2.1 Receiving
BNYCVF02.C02 0000215718 A.3 B.2 A.7 1/2/20, 2:22 PM Released

1. Device Master waits for the Load Allowed input before telling Miltrac™ that the Storage
Belt device wants to receive a load. Miltrac™ responds with the Get Ready command.

2. The belt waits for the Miltrac™ controller to command it to Start Receiving.
3. After the Start Receiving command, the Storage Belt waits for goods discharged from the

loading device to block the load end photoeye.
4. The belt runs when goods from the loading device block the load end photoeye.
5. The belt stops when goods block the discharge end eye.
6. If the photoeye is not actuated within the time specified by the configured Clear Belt Time,

the Device Master controller signals an error (01 NO TRANSFER).

7. If necessary, press Signal Cancel ( ) on the switch panel to clear this error and initialize
the belt.

TIP: In certain applications, the load end photoeye input is grounded so the belt runs
immediately when the Miltrac™ controller commands it to start receiving.

2.2.2 Discharging
BNYCVF02.C03 0000215717 B.2 A.4 A.7 1/2/20, 2:22 PM Released

1. Once loaded, the belt waits to be discharged.
• For Miltrac™ discharge, Device Master waits for the Discharge Allowed input before

telling Miltrac™ that the Storage Belt device wants to discharge. Miltrac™ tells the Stor-
age Belt when to start the discharge.

• For discharge to an allied device, the belt runs when the Storage Belt device sees the Dis-
charge Allowed input.

2. The belt stops and the system resets for another load after Clear Belt Time expires and the
discharge end photoeye clears.
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BNYCVF03 / 2019033 BNYCVF03 0000215304 A.8 1/2/20, 2:22 PM Released

2.3 Device Type 2: Non-storage Belt
BNYCVF03.C01 0000215303 B.2 A.5 A.8 1/2/20, 2:22 PM Released

The Non-storage Belt device is a Device Master-controlled conveyor belt which receives but does
not store goods discharged from a Milnor® device. The Non-storage Belt is not required to be a
physical device. As a “phantom” device, the Non-storage Belt is often used as a bridge between
two transferring devices in a Miltrac™ system that are separated by one X-coordinate value. Be-
cause the Non-storage Belt device cannot store goods, it can only accept a load if it can immedi-
ately discharge that same load. Non-storage Belts can only receive goods from a Milnor®
Miltrac™-controlled device, but can discharge to either a Miltrac™ or non-Miltrac™ (allied) de-
vice. The Non-storage Belt device has no photoeyes, but can run in either direction.
The Non-storage Belt device may be configured to pass allied data and/or allied weight. It may al-
so be configured to extend, if so equipped, and/or to work with a sequencing belt.

2.3.1 For Version 21106 and Later of Software WUDEVMASF
BNYCVF03.C02 0000215716 A.3 B.2 A.8 1/2/20, 2:22 PM Released

For Miltrac™ discharge, the Non-storage Belt device runs in the direction specified by the Direc-
tion for Load Device decision in the receiving device.

2.3.2 For Software Versions Before 21106
BNYCVF03.C03 0000215715 A.3 B.2 A.8 1/2/20, 2:22 PM Released

For Miltrac™ discharge, the Non-storage Belt uses the discharge end Get Ready command from
Miltrac™ to determine which direction to run its belt. (Refer to Section 2.1 : Device Type 0: Dry-
er Unloader, page 29 for more information on the Get Ready command.) This requires that the
Non-storage Belt be configured in Miltrac™ as a movable device if its Y coordinate is different
than the Y coordinate of the device that receives from it.

2.3.3 Receiving
BNYCVF03.C04 0000215714 A.3 B.2 A.8 1/2/20, 2:22 PM Released

A Non-storage Belt device is allowed to accept a load only if it is also allowed to discharge (i.e.,
both the loading device and the receiving device must be ready). Device Master waits for the
Load Allowed input before telling Miltrac™ that the Non-storage Belt device wants to receive.

2.3.4 Discharging
BNYCVF03.C05 0000215713 B.2 A.4 A.8 1/2/20, 2:22 PM Released

1. The belt begins discharging when both the device from which it receives goods and the device
to which it discharges are ready to transfer.
• For discharge to a Miltrac™ device, Device Master waits for the Discharge Allowed in-

put before telling Miltrac™ that the Non-storage Belt device wants to discharge. The belt
starts when the Miltrac™ controller commands it to Start Receiving and to Start
Transferring
– For software versions 21106 and later, belt direction is determined by the Direction

for Load Device decision in the device that will receive the load.
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– For software versions before 21106, belt direction is determined by the X-Y coordi-
nates configured in the Miltrac™ controller. The belt runs forward if the Miltrac™
controller commands the Non-storage Belt to Get Ready or to Get Ready Right. The
belt runs in reverse if Miltrac™ commands Get Ready Left.

• For discharge to an allied device, the belt starts when the Discharge Allowed input to the
Device Master controller is grounded and Miltrac™ commands the Non-storage Belt to
Start Receiving. Belt direction is determined by the Discharge Direction decision for
this device in the Configure/Devices menu selection.

2. Because the Non-storage Belt device has no photoeyes, it depends on the loading and, for
Miltrac™ discharge, the unloading device(s) to end the transfer. For Miltrac™ discharge, the
belt stops and transfer is complete when Miltrac™ issues the You're Finished (Discharging)
command. For allied discharge, the belt runs for Clear Belt Time after Miltrac™ issues the
You're Finished (Receiving) command.

BNYCVF04 / 2019033 BNYCVF04 0000215442 A.8 1/2/20, 2:22 PM Released

2.4 Device Type 3: Allied Dryer (Dryer Handler)
BNYCVF04.C01 0000215441 B.2 A.4 A.8 1/2/20, 2:22 PM Released

2.4.1 Description
BNYCVF04.C06 0000217035 B.2 A.5 A.8 1/2/20, 2:22 PM Released

The Allied Dryer is a Device Master-controlled device which provides an interface to a non-Mil-
nor® (allied) dryer in a Miltrac™ system. The Allied Dryer can be loaded manually, or it can re-
ceive goods from a Milnor® Miltrac™-controlled device, and it can discharge to either a
Miltrac™ or non-Miltrac™ (allied) device. This device may be configured to pass allied data
and/or allied weight.

2.4.2 Receiving
BNYCVF04.C02 0000215770 A.3 B.2 A.8 1/2/20, 2:22 PM Released

2.4.2.1 Miltrac™ Loading
BNYCVF04.C03 0000215769 B.2 A.5 A.8 1/2/20, 2:22 PM Released

For Miltrac™ loading, the Device Master controller provides for automated loading of the allied
dryer through this process:
1. Device Master waits for the Load Allowed and Load Desired inputs before telling Miltrac™

that the dryer wants to receive a load.
2. The Miltrac™ controller sends a Get Ready command to the Device Master controller. De-

vice Master turns on an output to signal the allied dryer that it is Allowed to Load. The dryer
responds by opening its load door.

3. When the dryer load door is open, Device Master tells the Miltrac™ controller that the dryer
is ready to receive a load. At the same time, Device Master locks in the data on the goods the
dryer will receive.

4. Miltrac™ instructs the loading device to load the dryer.

Devices



34 Pellerin Milnor Corporation

5. When the loading device discharges the first cake into the dryer, Device Master turns on an
output to signal that the Dryer is Loaded. The dryer receives additional cakes up to the maxi-
mum number of cakes as configured for Number of Storage Positions.

6. If the loading device delivered less than the maximum number of cakes to the dryer, Device
Master turns on a Partial Load output to signal the dryer that it received less than a full load.

7. When the loading device finishes loading the dryer, Device Master turns off the Allowed to
Load output, signalling the dryer to close the load door.

2.4.2.2 Allied Loading
BNYCVF04.C04 0000215781 A.3 B.2 A.8 1/2/20, 2:22 PM Released

For allied loading, the dryer is loaded manually. The Device Master controller receives an input
that says the dryer is loaded.

2.4.3 Discharging
BNYCVF04.C05 0000215780 A.3 B.2 A.8 1/2/20, 2:22 PM Released

1. Device Master waits to see the Discharge Allowed and Discharge Desired inputs.
• For a Miltrac™ discharge, Device Master signals the Miltrac™ controller that the dryer is

ready to discharge, then waits for the Start Discharging command. When Device Master
receives the Start Discharging command, it turns on an output to signal the allied dryer
that it is Allowed to Discharge.

• For an allied discharge, the Device Master controller turns on an output to signal the allied
dryer that it is Allowed to Discharge.

2. Device Master waits for the dryer to open and close its discharge door, signalling that the dis-
charge is finished.
• For a Miltrac™ discharge, Device Master signals the Miltrac™ controller that the dryer

has successfully discharged, then Device Master resets to wait for the next load.
• For an allied discharge, Device Master simply resets when the dryer discharge door

closes.

BNYCVF05 / 2019033 BNYCVF05 0000215452 A.5 1/2/20, 2:22 PM Released

2.5 Device Type 4: Allied Hand Loader
BNYCVF05.C01 0000215451 B.2 A.4 A.5 1/2/20, 2:22 PM Released

The Allied Hand Loader device is a Device Master-controlled manually loaded conveyor belt
used to load a Milnor® device controlled by Miltrac™. The Allied Hand Loader provides 6 binary
coded inputs for wash code (01 through 64), allowing the operator to enter a wash code to be
passed to the washer-extractor via the Miltrac™ controller. The Device Master controller then re-
ceives two inputs: one to signal that the data is valid, and one to signal that the belt is loaded. The
Allied Hand Loader is always loaded manually and discharges to a Miltrac™-controlled device.
The belt runs in only one direction and is equipped with one photoeye at the discharge end. Allied
Hand Loader may be configured to work with a compacting belt.
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2.5.1 Receiving (Manual Loading)
BNYCVF05.C02 0000215779 A.3 B.2 A.5 1/2/20, 2:22 PM Released

1. The Device Master controller turns on an output to signal that the Allied Hand Loader belt de-
sires a load.

2. The operator manually loads goods onto the belt. The belt controlled by the Allied Hand
Loader does not move during loading unless it is configured to jog while loading.

3. The operator dials in a wash code from 1 to 64, then makes the Data Valid input to lock in
the wash code.

4. The operator next makes an input to indicate that the Belt is Loaded. This turns off the Belt
Desires a Load output.

2.5.2 Discharging to a Miltrac™ Device
BNYCVF05.C03 0000215778 A.3 B.2 A.5 1/2/20, 2:22 PM Released

1. The belt runs in the forward direction until the goods block the photoeye. If the photoeye is
not actuated within the time specified by Clear Belt time, Device Master signals an error (03
NO GOODS). Press Signal Cancel ( ) on the Device Master switch panel to clear this error.

2. If the Discharge Allowed input is grounded, the Device Master controller signals the Mil-
trac™ controller that the Allied Hand Loader belt wants to unload, then Device Master waits
for Miltrac™ to respond.

3. When Miltrac™ responds to Device Master with the Get Ready command, Device Master
drops a flag to stop the receiving device, responds to Miltrac™ that the belt is ready to dis-
charge, and waits for Miltrac™ to respond.

4. When the receiving device is in position and Miltrac™ signals Device Master to begin un-
loading the belt, Device Master starts the belt. If Device Master is interrupted during the dis-
charge sequence, it signals an error (01 NO TRANSFER). Press Signal Cancel ( ) to clear
this error.

5. The belt stops after the Clear Belt time expires and the photoeye is clear. Device Master sig-
nals Belt Finished Unloading for two seconds.

6. Five seconds later, Device Master checks to see that Belt Loaded and Data Valid have been
reset; Device Master displays an error (02 NOT RESET) if they have not. Press Signal Cancel
( ) to clear this error.

7. Normally the Belt Loaded and Data Valid switches reset and Device Master turns on the out-
put to signal Desires Load to repeat the sequence.

BNYCVF06 / 2019033 BNYCVF06 0000215462 A.5 1/2/20, 2:22 PM Released

2.6 Device Type 5: Feeder Belt
BNYCVF06.C01 0000215461 B.2 A.4 A.5 1/2/20, 2:22 PM Released

The Feeder Belt device is a Device Master-controlled conveyor belt which receives and stores
goods discharged from a Milnor® device for manual unloading by an operator. The Feeder Belt
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has a photoeye on each end and runs in one direction. This device is always loaded by a Milnor®
Miltrac™-controlled device and always discharges manually.

2.6.1 Operational Summary
BNYCVF06.C02 0000215924 A.3 B.2 A.5 1/2/20, 2:22 PM Released

If the load end photoeye (same as the backward photoeye or the feeder photoeye) is clear, then
the Feeder Belt signals the Miltrac™ controller that it desires a load. If the discharge end photo-
eye (same as the forward photoeye) is clear, the Feeder Belt runs until the discharge end photoeye
is blocked or clear belt time runs out, whichever occurs first.

2.6.2 Receiving
BNYCVF06.C03 0000215923 A.3 B.2 A.5 1/2/20, 2:22 PM Released

1. The Feeder Belt desires a load whenever the load end photoeye is not blocked.
2. When the Miltrac™ controller commands the Feeder Belt to start loading, the belt runs con-

tinuously until the discharge photoeye is blocked.
3. When the discharge photoeye is blocked, the Feeder Belt signals the Miltrac™ controller that

the belt is loaded by sending a Finished Loading status to Miltrac™.

2.6.3 Manually Unloading
BNYCVF06.C04 0000215922 A.3 B.2 A.5 1/2/20, 2:22 PM Released

1. The Feeder Belt runs as necessary to keep the discharge end photoeye blocked as the operator
manually removes goods from the discharge end of the belt.

2. If the belt runs continuously for Clear Belt time without blocking the discharge end photoeye,
the Feeder Belt signals the Miltrac™ controller that the belt is empty and waiting for the next
load.

3. If the belt runs for Clear Belt time without blocking the discharge end photoeye while the
load end photoeye is blocked, the Device Master controller displays an error (Eye Blocked).

BNYCVF07 / 2019033 BNYCVF07 0000215514 A.7 1/2/20, 2:22 PM Released

2.7 Device Type 6: Sequencing Belt
BNYCVF07.C01 0000215513 B.2 A.4 A.7 1/2/20, 2:22 PM Released

The Sequencing Belt device is a Device Master-controlled conveyor belt which receives and
stores goods discharged from another Device Master-controlled belt for manual unloading by an
operator. The Sequencing Belt has a photoeye on each end and a third (sequencing) photoeye to
work with other belts. The belt runs in one direction. The Sequencing Belt always uses Miltrac™
protocol for loading and allied protocol for discharging. This device wants to receive a load any-
time the load end (backward or feeder) photoeye is clear. If the discharge end (forward) photoeye
is clear, the belt runs until the photoeye is blocked or the Clear Belt time expires, whichever oc-
curs first.
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2.7.1 Description
BNYCVF07.C02 0000215921 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The Sequencing Belt receives goods from a Device Master belt and is manually unloaded. Each
Device Master system may have only one sequencing system for every eight devices, and each
system may have up to two Sequencing Belts. For the first eight devices, the Sequencing Belts
must be configured as Device Master devices number 5 or number 6. At least one other belt in
this Device Master system—configured as either a Dryer Unloader or Non-Storage Belt and de-
vice number 0 through 7—must be configured to work with this/these Sequencing Belt(s). For the
second eight devices, the Sequencing Belts must be configured as Device Master devices number
13 or number 14. At least one other belt in this Device Master system—configured as either a
Dryer Unloader or Non-Storage Belt and device number 8 through 15—must be configured to
work with this/these Sequencing Belt(s).

2.7.2 Receiving
BNYCVF07.C03 0000215920 B.2 A.5 A.7 1/2/20, 2:22 PM Released

1. The Sequencing Belt signals the Miltrac™ controller that it desires a load when the load end
photoeye is clear and Load Allowed input is made.

2. When Miltrac™ commands the Sequencing Belt to start loading, the Sequencing Belt runs
continuously until the discharge end eye is blocked or contact Auto-Manual is made.

3. The Device Master belt configured to work with the Sequencing Belt runs to discharge its load
to the Sequencing Belt as it normally discharges to other devices.

4. After the sequencing photoeye is blocked, the loading belt controlled by Device Master runs
for the time specified by Sequencing On time.

5. When the Sequencing On time expires, the belt stops for the time specified by Sequencing
Off time. Once the sequencing eye clears, loading belt controlled by Device Master resumes
running.

6. If the contact Auto-Manual is made, the loading belt controlled by Device Master stops until
the contact Auto-Manual is cleared.

7. Once the Sequencing Belt discharge end photoeye is blocked, the Sequencing Belt signals the
Miltrac™ controller that the belt is loaded by sending a Finished Loading status to
Miltrac™.

2.7.3 Discharging
BNYCVF07.C04 0000215919 A.3 B.2 A.7 1/2/20, 2:22 PM Released

The Sequencing Belt runs to keep the discharge photoeye blocked while the operator removes
goods from the discharge end of the belt. If the belt runs continuously for Clear Belt time without
blocking the photoeye, the Sequencing Belt signals that it wants a load and waits for the next
load.
If the Sequencing Belt runs for Clear Belt Time without blocking the discharge end photoeye
and the load end eye is blocked, then Device Master signals an error (Eye Blocked).
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BNYCVF08 / 2019033 BNYCVF08 0000215524 A.7 1/2/20, 2:22 PM Released

2.8 Device 7: Linear Costa
BNYCVF08.C01 0000215523 B.2 A.4 A.7 1/2/20, 2:22 PM Released

The Linear Costa device is a Device Master-controlled conveyor belt which can receive and store
up to eight separate cakes. A Linear Costa belt can receive from either a Milnor® Miltrac™-con-
trolled device or a non-Miltrac™ (allied) device, and can discharge to either a Miltrac™ or non-
Miltrac™ (allied) device. The Linear Costa belt has photoeyes on both ends, runs forward to re-
ceive, and, when discharging to a Miltrac™-controlled device, runs in the direction specified by
the Direction For Load Device decision in the receiving device. The Linear Costa device may
be configured for allied data passing, allied weight passing, allied weight reading, and/or allied
compatibility.

2.8.1 Receiving
BNYCVF08.C02 0000215918 A.3 B.2 A.7 1/2/20, 2:22 PM Released

2.8.1.1 Miltrac Loading
BNYCVF08.C03 0000215917 A.3 B.2 A.7 1/2/20, 2:22 PM Released

1. Device Master waits for the In Load Position input before telling Miltrac™ that the Linear
Costa device wants to receive a load. Miltrac™ responds with the Get Ready command.

2. Device Master tells Miltrac™ that Linear Costa is ready to receive and waits for the Miltrac™
controller command to Start Receiving.

3. Following the Start Receiving command, the Linear Costa belt begins to run when goods
from the loading device block the load end photoeye.

4. The belt stops when goods from the loading device have cleared the load end photoeye for
the time specified by the configured value for Time After Trailing Edge In 10ths.

5. Device Master tells Miltrac™ that the Linear Costa is finished receiving. Since the Linear
Costa is a multiple-cake storage device, this acknowledgement has two variations:
• The receive status Done Receiving (without an asterisk) implies that the Linear Costa belt

is finished receiving and can take another cake.
• The receive status Done Receiving * (with an asterisk) implies that the Linear Costa belt

is finished receiving and cannot take another cake (belt is full).
6. If the Linear Costa belt can take another cake and the loading device can pass another cake,

then Miltrac™ issues the Get Ready command, and the loading process is repeated. Other-
wise, Miltrac™ issues the Do Nothing command, and the loading process ends.

7. If Linear Costa is configured for Discharge Eye Loading Error, and the discharge end eye
is blocked during the loading process, the Device Master controller signals an error (07 EYE
LOADING ERROR). Press Signal Cancel on the control panel to clear this error and initial-
ize the belt.

2.8.1.2 Allied Loading
BNYCVF08.C04 0000215916 A.3 B.2 A.7 1/2/20, 2:22 PM Released

1. When the In Load Position input is made, theWant To Load output turns on.
2. When the Get Ready To Load input is made, the Ready To Load output turns on.
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3. When the Start Loading input is made, Device Master reads the cake data inputs. The Linear
Costa belt begins to run when goods from the loading device block the load end photoeye.

4. The belt stops when goods from the loading device have cleared the load end photoeye for
the time specified by the configured value for Time After Trailing Edge In 10ths.

5. TheWant To Load and the Ready To Load outputs reset, and the Finished Loading output
turns on for 4 seconds.

6. If the Linear Costa belt can take another cake, theWant To Load output turns on and the
loading process repeats.

7. If Linear Costa is configured for Discharge Eye Loading Error, and the discharge end eye
is blocked during the loading process, the Device Master controller signals an error (07 EYE
LOADING ERROR). Press Signal Cancel on the control panel to clear this error and initial-
ize the belt.

2.8.2 Discharging
BNYCVF08.C05 0000215915 A.3 B.2 A.7 1/2/20, 2:22 PM Released

2.8.2.1 Miltrac Discharge
BNYCVF08.C06 0000215975 B.2 A.5 A.7 1/2/20, 2:22 PM Released

1. With the In Discharge Position input made, Device Master waits until either the number of
cakes loaded equals or exceeds the value configured for Optimum Number Of Cakes To
Unload, or the time configured forWait To Unload Less Than Optimum expires, before
telling Miltrac™ that the Linear Costa device wants to discharge a load. Miltrac™ responds
with the Get Ready command.

2. Device Master tells Miltrac™ that Linear Costa is ready to discharge and waits for the Mil-
trac™ controller command to Start Transferring.

3. Following the Start Transferring command, the Linear Costa belt begins to run in the direc-
tion specified by the Direction For Load Device setting in the receiving device.

4. If more than one cake is on the belt, the belt stops after the discharged cake clears the belt eye
and the next cake blocks the eye. If only one cake is on the belt, the belt stops after the cake
has cleared the photoeye for the time specified by the configured value for Run Time After
Discharge if it's not zero, or Clear Belt Time, otherwise.

5. Device Master tells Miltrac™ that the Linear Costa is finished discharging. Since the Linear
Costa is a multiple-cake stoarge device, this acknowledgement has two variations:
• The transfer status Done Transferring (without an asterisk) implies that the Linear Costa

belt is finished discharging and can pass another cake.
• The transfer status Done Transferring (without an asterisk) implies that the Linear Costa

belt is finished discharging and cannot pass another cake.
6. If the Linear Costa belt can pass another cake and the receiving device can take another cake,

then Miltrac™ issues the Get Ready command, and the discharging process is repeated until
either the Linear Costa belt is empty or, if the receiving device is full, the time configured for
Wait For Receive Device Time expires.

7. If the discharging process ends before the Linear Costa belt is empty, the belt re-initializes its
remaining cakes to the receive end in preparation for loading.
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8. If the Linear Costa is configured for Hold Receiving Device, and the receiving device can
take another cake but the Linear Costa belt is empty, Device Master will delay telling Mil-
trac™ that Linear Costa is finished discharging in order to hold the receiving device until Lin-
ear Costa can pass another cake.

2.8.2.2 Allied Discharge
BNYCVF08.C07 0000215974 A.3 B.2 A.7 1/2/20, 2:22 PM Released

1. With the In Discharge Position input made, Device Master waits until either the number of
cakes loaded equals or exceeds the value configured for Optimum Number Of Cakes To
Unload, or the time configured forWait To Unload Less Than Optimum expires, before ac-
tivating theWant To Discharge and allied data outputs.

2. When the Get Ready To Discharge input is made, the Ready To Discharge output turns on.
3. When the Start Discharging input is made, the Linear Costa belt begins to run forward.
4. If more than one cake is on the belt, the belt stops after the discharged cake clears the belt eye

and the next cake blocks the eye. If only one cake is on the belt, the belt stops after the cake
has cleared the photoeye for the time specified by the configured value for Run Time After
Discharge if it's not zero, or Clear Belt Time, otherwise.

5. The discharge process repeats until the total number of cakes discharged is greater than or
equal to the value configured for Optimum Number Of Cakes To Unload, or the Linear
Costa belt is empty. At that time, theWant To Discharge and Ready To Discharge outputs
reset, and the Finished Discharging output turns on for 4 seconds. The input Allied Transfer
Cancelled may be used to end the discharge process before Optimum Number of Cakes to
Unload is achieved.

6. If the discharging process ends before the Linear Costa belt is empty, the belt re-initializes its
remaining cakes to the receive end in preparation for loading.
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BNYCVP01 / 2019033 BNYCVP01 0000215177 A.8 1/2/20, 2:22 PM Released

3.1 Configuring the Device Master Controller
BNYCVP01.C01 0000215176 B.2 A.4 A.8 1/2/20, 2:22 PM Released

3.1.1 System Configuration
BNYCVP01.C02 0000216072 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Access the System Configuration screen from the Device Master main display, as shown in Fig-
ure 33, page 41.
Figure 33. Displaying the System Configuration Screen

Figure 34. Device Master Configuration Screen
Typical Display Legend

A...General configuration decisions
B...Options decisions
C...Allied data pass output

assignments
D...Allied weight output format
E...Help text
F...Action buttons
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3.1.1.1 General Decisions and Options
BNYCVP01.C03 0000216069 A.3 B.2 A.8 1/2/20, 2:22 PM Released

3.1.1.1.1 General Decisions
BNYCVP01.C04 0000216068 A.3 B.2 A.8 1/2/20, 2:22 PM Released

3.1.1.1.1.1 Language
BNYCVP01.C05 0000216067 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Select the desired language from the list. All pages, menus, and help screens will appear in this
language the next time the Device Master software is started.
Display or Action Explanation

Typical language selection list. The appearance and content of this
list may change.

3.1.1.1.1.2 Miltrac™ Address
BNYCVP01.C06 0000216065 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the address for the first Device Master device on the Miltrac™ system. The address for the
second device will be assigned one address location higher, and the address of each subsequent
device increments by one.

TIP: If the Device Master address is 003 and two devices are enabled, then Device 0 =
003, and Device 1 = 004.

3.1.1.1.1.3 Bytes for Network String
BNYCVP01.C07 0000216099 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Select the number of bytes used to communicate with Miltrac™. Select 24 or 30 for older Mil-
trac™ systems, or 00 for new Miltrac™. Use Table 4, page 42 and the version and date code of
the Miltrac™ software to determine this setting. See Table 5, page 43 for PC-based Miltrac™
systems.
Table 4. Bytes in Miltrac™ Network String
Miltrac™ Processor Board Protocol Miltrac™ Software Version

8088 Old before WUMILTRACB/89100
New WUMILTRACB/89100 and later

early 80186 (08BSPET) Old WUMILTCC/93xxx
New WUMILTCB/94xxx

current 80186 (08BSPE1T/2T) Old WUMILTCE/99xxx
New WUMILTCD/20xxx

PC-based
New WUPCMILTRC/20xxx

Expand WUPCMILTRD/21xxx
Note: "xxx" represents last three digits of version number.
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For expanded Miltrac™, select the code from Table 5, page 43 that provides the fastest reliable
baud rate. The fastest reliable baud rate may be limited by electronic noise in the facility, cable
length and routing, and other factors.
Table 5. Baud Rates for Expanded Miltrac™ Protocol

Select this code to communicate at this baud rate
96 9600
97 19200
98 38400
99 57600

3.1.1.1.1.4 Mildata® Address
BNYCVP01.C08 0000216098 A.3 B.2 A.8 1/2/20, 2:22 PM Released

For Device Master controllers with software dated 21103 and earlier, enter the address for the De-
vice Master controller on the Mildata® network. The valid values for this decision are 0 to 255.
For Device Master controllers with software dated 21104 and later, the Mildata® address entered
here corresponds to device 0, and the Mildata® address for all Device Master devices increments
by 1 from the address of the Device Master controller. The valid values for the Device Master
controller address are 0 to (255 minus the number of Device Master devices).

3.1.1.1.1.5 Total Number of Devices
BNYCVP01.C09 0000216097 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the total number of devices controlled by this Device Master controller. Each Device Mas-
ter can control from one to 16 devices.

3.1.1.1.1.6 Goods Unit
BNYCVP01.C10 0000216096 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Enter the unit used to measure goods in this system, eitherWeight or Pieces.

3.1.1.1.1.7 Weight Units
BNYCVP01.C11 0000216095 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This decision appears only if the Goods Unit for this system isWeight. Select either LBS to
measure pounds, or KGS to measure kilograms.

3.1.1.1.2 Options
BNYCVP01.C12 0000216094 A.3 B.2 A.8 1/2/20, 2:22 PM Released

3.1.1.1.2.1 Signal Option
BNYCVP01.C13 0000216093 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Enabling this option requires an additional output board set to address 11H for the first eight devi-
ces, or set to 91H for the second eight devices. This option provides two signals for each Device
Master-controlled device.
• The Load Waiting signal is enabled when the device desires to discharge and cannot. This

output applies to these devices: Dryer Unloader, Storage Belt, Non-storage Belt, and Dryer
Handler.

• The Goods Different from Last signal is enabled when the goods on the device differ from
the goods in the previous batch. This output applies to all devices except Allied Hand Loader.
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3.1.1.1.2.2 Flag Option
BNYCVP01.C14 0000216092 B.2 A.5 A.8 1/2/20, 2:22 PM Released

If selected, this option requires an additional input/output board set to address 05H for the first
eight devices, or to 85H for the second eight devices. The Flag option provides one Flag Down
output for each Device Master-controlled device. This output is used to drop a target for shuttle
transfers. This output may be configured for either load end or discharge end operation as de-
scribed in Section 3.1.2.3.22.4 : Flag Down End, page 53, and works with both Miltrac™ and al-
lied transfers.
The Flag option applies to all Device Master-controlled devices except Allied Hand Loader,
which provides the Flag Down signal as a standard output.

3.1.1.1.2.3 Signal Belt Transfer Status
BNYCVP01.C15 0000216091 A.3 B.2 A.8 1/2/20, 2:22 PM Released

If selected, this option requires an additional output board set to address 1AH for the first eight
devices, or to 9AH for the second eight devices, to provide a Finished discharging signal for use
with allied discharge for each Device Master-controlled device. This option applies only to Dryer
Unloader, Storage Belt, and Non-storage Belt devices.
In operation, the Finished discharging signal is enabled for 5 seconds beginning when the device
completes its discharge.

3.1.1.1.2.4 Reset on Belt Load Error
BNYCVP01.C16 0000216090 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This option applies only to Allied Hand Loader devices and requires no additional boards. If se-
lected, this option allows the Device Master controller to automatically cancel a Miltrac™ trans-
fer following an error condition.

3.1.1.2 Allied Weight
BNYCVP01.C17 0000216220 B.2 A.8 5/7/20, 4:10 PM Released

Under the Allied Weight configuration the user specifies whether the output format for passing
allied weight will be in ones units (whole units) or tenths of units, where units are either pounds
or kilograms. The actual cake weight can be determined by multiplying the binary output value
by the appropriate multiplier: 0.1 for tenths of units, or 1.0 for ones units. For example, the binary
output value for a cake weighing 102.3 pounds would be

1023 x 0.1 = 102.3 for tenths

or
102 x 1.0 = 102.0 for ones

NOTE: Fractional units are truncated when ones units are used.

Table 6. Example

Output Format Binary Output from 24-output Board
Binary
Output
Value

Cake Weight

Tenths of Units 0000 0000 0000 0011 1111 1111 1023 1023 x 0.1 = 102.3
Ones Units 0000 0000 0000 0000 0110 0110 102 102 x 1.0 = 102.0
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3.1.1.3 Allied Data Pass
BNYCVP01.C18 0000216255 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Under the Allied Data Pass configuration, the user must specify, for each data value, how many
outputs are needed to pass that value in binary format. The Allied Data Pass relay assignments
specified here apply to all Device Master-controlled devices configured for Allied Data Passing
as described in Section 3.1.2.4.4 : Allied Data Passing, page 54. Any data value may be assigned
up to 16 outputs, with a maximum total of 24 outputs for all data values combined. Outputs are
applied from highest to lowest order according to the following sequence:
1. Formula
2. Dry code
3. Destination
4. Customer
5. Goods code
6. Cake number
Table 7. Example of Allied Data Pass Output Assignments

Batch Data Type Desired Data Range
Outputs Required for De-

sired Range
Formula 00–15 4
Dry code 00–15 4
Destination 00–15 4
Customer 00–31 5
Goods code 000–127 7
Cake number none 0
Figure 35. Data and Board Outputs for Allied Data Pass Example

Output Assignments (from Table 4) Legend
A...Four outputs for 16 formula. . codes
B...Four outputs for 16 dry codes. .
C...Four outputs for 16 destination. .

codes
D...Five outputs for 32 customer. .

codes
E...Seven outputs for 128 goods codes.

.
....No outputs are assigned for cake num-

ber. . .
1...Data outputs (output relays corresponding

to batch codes)
2...Allied data (output relays corresponding to

24-output board)
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3.1.2 Device Configuration
BNYCVP01.C19 0000216251 B.2 A.4 A.8 1/2/20, 2:22 PM Released

The Device Selection Window (Figure 36, page 46) is displayed when the Configure/Devices
menu item is selected, as shown in Figure 33: Displaying the System Configuration Screen, page
41 .
Figure 36. Device Selection Window

To display the Device Configuration screen (Figure 37, page 46), click the mouse on the Config-
ure button in the Device Selection window. To exit the Device Selection menu without making
any changes, click on the Exit button.
Figure 37. Device Configuration Screen

Typical Display Legend
A...Device number
B...Load data configuration
C...Device name
D...Device type
E...Options configuration
F...Allied compatibility data

(applicable device types
only)

G...Help text
H...Action buttons
I...Discharge data

configuration
J...Generic data configuration
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3.1.2.1 Device Name
BNYCVP01.C20 0000216250 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This field allows the entry of 10 alphanumeric or symbol characters to identify the device on all
other Device Master display screens. This name appears at the top of the box corresponding to
the device on the Device Master Cake page and State page, and in the upper left corner of the
Manual page and the Inputs and Outputs page.

3.1.2.2 Device Type
BNYCVP01.C21 0000216249 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Each device operated by the Device Master controller is one of the eight types described in Sec-
tion 2.1 : Device Type 0: Dryer Unloader, page 29 through Section 2.8 : Device 7: Linear Costa,
page 38 of this manual. The Device Master controller uses this decision to determine the valid
values of all device configuration decisions except Device Name.
Device Type 0: Dryer Unloader (see Section 2.1 : Device Type 0: Dryer Unloader, page

29) a conveyor belt used to receive and store goods discharged from one or more Milnor®
dryers; always Miltrac™ loaded, Miltrac™ or allied discharge. The belt can run forward and
backward; capable of passing allied data, allied weight, or both to an allied device; may ex-
tend to load or unload; may operate with a sequencing belt.

Device Type 1: Storage Belt (see Section 2.2 : Device Type 1: Storage Belt, page 31) a con-
veyor belt used to receive and store goods discharged from a Miltrac™-controlled device; al-
ways Miltrac™ loaded, Miltrac™ or allied discharge. The belt runs in only one direction;
capable of passing allied data and/or allied weight, and configurable for allied compatibility;
may extend to load or unload; may operate with a compacting belt.

Device Type 2: Non-storage Belt (see Section 2.3 : Device Type 2: Non-storage Belt, page
32) a conveyor belt used to receive, but not to store, goods discharged from a Miltrac™-
controlled device; also used as a phantom device to bridge between two transferring devices
in a Miltrac™ system that are separated by one X-coordinate value. This device is always
Miltrac™ loaded; Miltrac™or allied discharge. Belt can run forward and backward; capable
of passing allied data, allied weight, or both to an allied device; may extend to load or unload;
may operate with a sequencing belt.

Device Type 3: Allied Dryer (see Section 2.4 : Device Type 3: Allied Dryer (Dryer Handler),
page 33) Also know as Dryer Handler, this device provides a Miltrac™ interface for a non-
Milnor® dryer; Miltrac™ or allied loading, Miltrac™ or allied discharge. Belt runs in one di-
rection only; capable of passing allied data and allied weight.

Device Type 4: Allied Hand Loader (see Section 2.5 : Device Type 4: Allied Hand Loader,
page 34) a manually loaded conveyor belt used to load a Miltrac™-controlled device; man-
ually loaded, Miltrac™ discharge only. Belt runs in one direction only; capable of passing al-
lied data and allied weight; may operate with a compacting belt.

Device Type 5: Feeder Belt (see Section 2.6 : Device Type 5: Feeder Belt, page 35) a con-
veyor belt used to receive goods from a Miltrac™-controlled device for manual unloading; al-
ways Miltrac™ loaded; manual discharge only. The belt runs in one direction only; cannot
pass allied data or allied weight.

Device Type 6: Sequencing Belt (see Section 2.7 : Device Type 6: Sequencing Belt, page
36) a conveyor belt used to receive goods from a Device Master-controlled belt (either a
Dryer Unloader or a Non-storage belt) for manual unloading; always Miltrac™ loaded, man-
ual discharge only. The belt runs in one direction only; cannot pass allied data or allied
weight.
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Device Type 7: Linear Costa (see Section 2.8 : Device 7: Linear Costa, page 38) a conveyor
belt used to receive and store up to eight separate cakes; Miltrac™ or allied loading, Mil-
trac™ or allied discharge. Belt can run forward and backward; capable of reading allied
weight from an allied loading device, and passing allied data, allied weight, or both to an al-
lied receiving device.

3.1.2.3 Load Data
BNYCVP01.C22 0000216248 A.3 B.2 A.8 1/2/20, 2:22 PM Released

The configure decisions under the Load Data section are used to specify the loading characteris-
tics of the device. Only those data fields which apply to the specified device type are displayed.
A data field which appears, but is not applicable based on one or more other configure decisions,
is displayed as grayed out and inaccessible.

3.1.2.3.1 Load Type
BNYCVP01.C23 0000216247 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the protocol used by this device for loading. This decision is configurable for Allied Dryer
and Linear Costa devices only.
Display or Action Explanation

Miltrac loading operation controlled by Miltrac™
Allied loading operation controlled via allied interfacing.

3.1.2.3.2 Loading Level
BNYCVP01.C24 0000216246 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This decision specifies the vertical position for an elevating device to discharge to this device. It
applies to Miltrac™ loading only, and is configurable for Dryer Unloader, Storage Belt, Non-
storage Belt, Linear Costa, and Allied Dryer devices.
Display or Action Explanation

0 default and minimum
7 maximum

3.1.2.3.3 Delay Before Run
BNYCVP01.C25 0000216292 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the desired time (in seconds) between when the device begins receiving a load and when
the belt begins running. A longer value here helps keep the goods bunched together rather than al-
lowing them to distribute along the length of the belt. Configurable for Dryer Unloader, Storage
Belt, and Allied Hand Loader devices.
Display or Action Explanation

0 minimum and default value; belt begins running when loading
starts

255 maximum value; belt begins running 255 seconds after loading
starts.
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3.1.2.3.4 Direction for Load Device
BNYCVP01.C26 0000216291 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the direction for the loading device to run the belt when it transfers the cake to this device;
applies to Miltrac™ loading only. Configurable for Dryer Unloader, Storage Belt, Non-storage
Belt, Linear Costa, and Allied Dryer devices.
Display or Action Explanation

Forward the loading device runs in the same direction it runs to receive a
load

Reverse the loading device runs in the direction opposite the way it runs
when receiving a load

3.1.2.3.5 Loading On Time
BNYCVP01.C27 0000216290 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the load sequence jog ON time in seconds; configurable for Dryer Unloader, Storage Belt,
and Allied Hand Loader devices.
Display or Action Explanation

0 minimum and default value; belt does not run during loading
255 maximum value; belt runs continuously for 255 seconds while re-

ceiving a load, then pauses for the configured Loading Off Time
(below).

3.1.2.3.6 Loading Off Time
BNYCVP01.C28 0000216289 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the load sequence jog OFF time in seconds; configurable for Dryer Unloader, Storage Belt,
and Allied Hand Loader devices.
Display or Action Explanation

0 minimum and default value; belt runs continuously during loading
255 maximum value; after running for the configured Belt On Time,

the belt pauses for 255 seconds while receiving a load. This se-
quence repeats according to the value for Number of Load Se-
quences (below).

3.1.2.3.7 Number of Load Sequences
BNYCVP01.C29 0000216288 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the number of times the load sequence of on/off jogs should be performed; configurable for
Dryer Unloader, Storage Belt, and Allied Hand Loader devices.
Display or Action Explanation

0 default and minimum
99 maximum value
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3.1.2.3.8 Time After Trailing Edge in 10ths
BNYCVP01.C30 0000216287 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the desired time, in tenths of a second, for this device to continue running its belt during
loading after the cake passes the load end photoeye. This decision is used to set the spacing be-
tween cakes on the belt. Configurable for Linear Costa only.
Display or Action Explanation

0 default and minimum
99 maximum value

3.1.2.3.9 Hold Loader When Belt is Full
BNYCVP01.C31 0000216286 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Enter the maximum time, in minutes, to hold the loading device if this device is full but the load-
ing device still has more cakes to discharge. Applies to Miltrac™ loading. Configurable for Line-
ar Costa only.
Display or Action Explanation

0 default and minimum
99 maximum value

3.1.2.3.10 Discharge Data
BNYCVP01.C32 0000216285 A.3 B.2 A.8 1/2/20, 2:22 PM Released

The configure decisions under the Discharge Data section are used to specify the discharging
characteristics of the device. Only those data fields which apply to the specified device type are
displayed. A data field which appears, but is not applicable based on one or more other configure
decisions, is displayed as grayed out and inaccessible.

3.1.2.3.11 Discharge Type
BNYCVP01.C33 0000216475 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Enter the protocol used by this device for discharging; configurable for Dryer Unloader, Storage
Belt, Non-storage Belt, Linear Costa, and Allied Dryer devices.
Display or Action Explanation

Miltrac™ loading operation controlled by Miltrac™
Allied loading operation controlled via allied interfacing.

3.1.2.3.12 Discharge Level
BNYCVP01.C34 0000216474 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This decision specifies the vertical position for an elevating device to receive from this device;
applies to Miltrac™ discharge only. Configurable for Dryer Unloader, Storage Belt, and Non-
storage Belt, and Linear Costa.
Display or Action Explanation

0 default and minimum
7 maximum
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3.1.2.3.13 Discharge Direction
BNYCVP01.C35 0000216473 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the direction for this device to run its belt when discharging a cake; applies to allied dis-
charge only. Configurable for Dryer Unloader and Non-storage Belt devices.
Display or Action Explanation

Forward the loading device runs in the same direction it runs to receive a
load

Reverse the loading device runs in the direction opposite the way it runs
when receiving a load

3.1.2.3.14 Direction for Receiving Device
BNYCVP01.C36 0000216472 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the direction for the receiving device to run the belt when taking a cake from this device;
applies to Miltrac™ discharge only. Configurable for Dryer Unloader, Storage Belt, Linear Cos-
ta, and Non-Storage Belt devices.
Display or Action Explanation

Forward the loading device runs in the same direction it runs to receive a
load

Reverse the loading device runs in the direction opposite the way it runs
when receiving a load

3.1.2.3.15 Compacting Time
BNYCVP01.C37 0000216471 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the time desired to run this belt in seconds after the goods clear the compacting eye. This
decision applies only if this device is configured to work with a compacting belt; configurable for
Storage Belt and Allied Hand Loader devices only.
Display or Action Explanation

0 default and minimum
255 maximum value

3.1.2.3.16 Sequencing On Time
BNYCVP01.C38 0000216470 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the desired time in seconds for this belt to continue running after the goods block the se-
quencing photoeye. Applies only if this device is configured to work with a sequencing belt; con-
figurable for Dryer Unloader and Non-storage Belt devices only.
Display or Action Explanation

0 default and minimum
255 maximum value
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3.1.2.3.17 Sequencing Off Time
BNYCVP01.C39 0000216469 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This is the number of seconds that this belt should pause after running for the sequencing ON
time; applies only if this device is configured to work with a sequencing belt. This decision ap-
plies only to Dryer Unloader and Non-storage Belt devices.
Display or Action Explanation

0 default and minimum
255 maximum value

3.1.2.3.18 Run Time after Discharge
BNYCVP01.C40 0000216468 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This decision determines how long, in seconds, the belt runs after the discharge end photoeye is
clear; configurable for Dryer Unloader, Storage Belt, Linear Costa, and Allied Hand Loader
devices.
Display or Action Explanation

0 minimum and default value; belt runs for configured Clear Belt
Time

255 maximum value; timer counts down with belt running when dis-
charge end photoeye clears. If goods block the belt before this
timer counts down to 0, the timer restarts at the value configured
here.

3.1.2.3.19 Optimum Number of Cakes to Unload
BNYCVP01.C41 0000216467 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the optimum number of cakes for this device to discharge. The device will delay discharg-
ing its cake(s) until either the optimum number of cakes is achieved, or the time configured for
Wait To Unload Less Than Optimum expires. Configurable for Linear Costa only.
Display or Action Explanation

1 minimum and default value
Number of Storage

Positions
maximum value

3.1.2.3.20 Wait to Unload Less Than Optimum
BNYCVP01.C42 0000216466 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the maximum time, in minutes, to wait to discharge the cake(s) if Optimum Number Of
Cakes To Unload is not met. Configurable for Linear Costa only.
Display or Action Explanation

0 default and minimum
99 maximum value

3.1.2.3.21 Wait for Receive Device Time
BNYCVP01.C43 0000216501 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the maximum time, in minutes, for this device to wait to discharge a cake when the receiv-
ing device is full. Applies to Miltrac™ discharge. Configurable for Linear Costa only.
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Display or Action Explanation
0 default and minimum
99 maximum value

3.1.2.3.22 Generic Data
BNYCVP01.C44 0000216500 A.3 B.2 A.8 1/2/20, 2:22 PM Released

The configure decisions under the Generic Data section are used to specify the generic character-
istics of the device. Only those data fields which apply to the specified device type are displayed.
A data field which appears, but is not applicable based on one or more other configure decisions,
is displayed as grayed out and inaccessible.

3.1.2.3.22.1 Maximum Number of Cakes
BNYCVP01.C45 0000216499 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the total number of like loads that can be assimilated by this device into a single load; con-
figurable for Allied Dryer and Storage Belt devices.
Display or Action Explanation

1 minimum and default value
8 maximum value

3.1.2.3.22.2 Number of Storage Positions
BNYCVP01.C46 0000216498 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Enter the maximum number of separate cakes that this device can load without having to dis-
charge. Configurable for Linear Costa only.
Display or Action Explanation

1 minimum and default value
8 maximum value

3.1.2.3.22.3 Clear Belt Time
BNYCVP01.C47 0000216497 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This time (seconds) should be set to completely clear the belt. This decision is configurable for
all devices except Allied Dryer.
Display or Action Explanation

0 default and minimum
255 maximum value

3.1.2.3.22.4 Flag Down End
BNYCVP01.C48 0000216496 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This decision applies only if Device Master is configured for the Flag Down option as explained
in Section 3.1.1.1.2.2 : Flag Option, page 44 and specifies which end of this device will be used
to drop the target. Configurable for Dryer Unloader, Storage Belt, Linear Costa, and Non-storage
Belt devices.
Display or Action Explanation

Load the target drops at the load end of the device
Discharge the target drops at the discharge end of the device
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3.1.2.3.22.5 Extendable Belt
BNYCVP01.C49 0000216539 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Configurable for Dryer Unloader, Storage Belt, and Non-storage Belt devices, these devices may
be equipped to extend during transfer. If selected, this option requires an additional 8-output/16-
input board set to address 00H for the first eight devices, and to 80H for the second eight devices.
Use this configure decision to specify how this belt is designed to extend.
Display or Action Explanation

Does Not Extend the belt does not extend
Extends to Load the belt extends toward the loading device to receive a load

Extends to Unload the belt extends toward the receiving device to discharge a load

3.1.2.4 Options
BNYCVP01.C50 0000216538 A.3 B.2 A.8 1/2/20, 2:22 PM Released

3.1.2.4.1 Allied Weight Reading
BNYCVP01.C51 0000216537 A.3 B.2 A.8 1/2/20, 2:22 PM Released

When this option is selected, an additional 8-output/16-input board is required which provides
the allied data inputs for reading the weight from the loading device. The board address depends
on the device number and equals 48H plus the device number for the first eight devices, or C8H
plus the device number minus eight for the second eight devices. For example, set the board ad-
dress to 48H for device 0, 49H for device 1, etc., up to 4FH for device 7. Set the board address to
C8H for device 8, C9H for device 9, etc., up to CFH for device 15. This option is configurable
for Linear Costa only.

3.1.2.4.2 Discharge Eye Loading Error
BNYCVP01.C52 0000216536 A.3 B.2 A.8 1/2/20, 2:22 PM Released

If this option is selected, the Device Master controller signals an error if the discharge eye is
blocked during loading. This option is configurable for Linear Costa only.

3.1.2.4.3 Hold Receiving Device
BNYCVP01.C53 0000216535 A.3 B.2 A.8 1/2/20, 2:22 PM Released

If selected, this option allows this device, when empty, to take more cakes from its loading device
while holding the receiving device until it is full. Otherwise, the receiving device will be released,
even if it can take more cakes, when this device is empty. This option is configurable for Dryer
Unloader, Storage Belt, Linear Costa, and Non-storage Belt devices.

3.1.2.4.4 Allied Data Passing
BNYCVP01.C54 0000216534 B.2 A.4 A.8 1/2/20, 2:22 PM Released

When this option, also known as Expanded Data, is selected, an additional output board is re-
quired to pass the allied data as specified by the allied data output assignments entered on the
System Configuration display (see Section 3.1.1.3 : Allied Data Pass, page 45). The output
board address depends on the device number and equals 12H plus the device number for the first
eight devices, or 92H plus the device number minus eight for the second eight devices. For exam-
ple, set the board address to 12H for device 0, 13H for device 1, etc., up to 19H for device 7. Set
the board address to 92H for device 8, 93H for device 9, etc., up to 99H for device 15. This option
is configurable for Dryer Unloader, Storage Belt, Non-storage Belt, Linear Costa, and Allied
Dryer devices.
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3.1.2.4.5 Allied Weight Passing
BNYCVP01.C55 0000216533 A.3 B.2 A.8 1/2/20, 2:22 PM Released

If selected, this option requires an additional output board to pass the allied weight as specified
by the allied weight output format selected on the System Configuration display (see Section
3.1.1.2 : Allied Weight, page 44). The setting of the output board address depends on the device
number and equals the sum of 52H plus the device number for the first eight devices (e.g., 52H
for device 0, up to 59H for device 7), and D2H plus the device number minus eight for the second
eight devices (e.g., D2H for device 8, up to D9H for device 15). This option is configurable for
Dryer Unloader, Storage Belt, Non-storage Belt, Linear Costa and Allied Dryer devices.

3.1.2.4.6 Allied Compatibility
BNYCVP01.C56 0000216532 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Configurable for Storage Belt and Linear Costa devices, this option applies to allied discharge
only. See Section 3.1.2.5 : Allied Compatibility, page 56 for an explanation of how to configure
Allied Compatibility.
Because a Storage Belt needs the Finished Discharging output to signal the allied receiving de-
vice when the discharge process is complete, the Signal Belt Transfer Status option must be en-
abled for the Allied Compatibility feature to work with a storage belt. Based on the Allied
Compatibility data configuration, the storage belt will try to discharge two consecutive compati-
ble loads to the allied receiving device before energizing the Finished Discharging output. After
discharging the first cake from the storage belt, Device Master turns on the Finished Discharg-
ing output if, while loading the second cake onto the storage belt, the two cakes are determined to
be incompatible.
The Signal Belt Transfer Status option is not applicable to Linear Costa, which uses its own
Finished Unloading output in conjunction with the Allied Compatibility feature. Based on the
Allied Compatibility data configuration, the Linear Costa belt will continue to pass consecutive
compatible loads to the allied receiving device until either the belt is empty or the receiving de-
vice is full. Linear Costa uses the Finished Unloading output to signal the receiving device when
the discharge process is complete.

3.1.2.4.7 Work with Compacting Belt
BNYCVP01.C57 0000216531 A.3 B.2 A.8 1/2/20, 2:22 PM Released

A compacting belt is usually a short belt installed vertically at the end of a Device Master-con-
trolled belt, designed to bunch the goods together at the end of the belt. If selected, this option re-
quires an additional 8-output/16-input board. Board address 0EH supports devices numbered 0
through 3; board address 0FH supports devices numbered 4 through 7; board address 8EH sup-
ports devices numbered 8 throught 11, board address 8FH supports devices numbered 12 through
15. The compacting belt option is configurable for Storage Belt and Allied Hand Loader devices.

3.1.2.4.8 Work with Sequencing Belt
BNYCVP01.C58 0000216530 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Select this option if this Device Master device discharges in conjuction with a sequencing belt.
Configurable for Dryer Unloader and Non-storage Belt devices only; this option does not require
additional boards.
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3.1.2.5 Allied Compatibility
BNYCVP01.C59 0000216802 A.3 B.2 A.8 1/2/20, 2:22 PM Released

This configuration section is enabled when Allied Compatibility is selected under Options.
Within the Allied Compatibility area, the user chooses which of the six data values will be used
to determine compatibility. For two cakes to be compatible, each of the selected data values must
be equivalent. See Section 3.1.1.3 : Allied Data Pass, page 45 for a complete description of each
type of goods data.

3.1.3 Quick Reference to Configuration Decisions
BNYCVP01.C60 0000216800 A.3 B.2 A.8 1/2/20, 2:22 PM Released

Figure 38. Quick Reference to Configuration Decisions
Parameters and Values/Ranges

Legend
1. A bullet (•) indicates that this parameter is configurable.
2. A numeric entry indicates a fixed value for this parameter.
3. A “n/a” entry indicates that this parameter is not applicable.

3.1.4 Pages Configuration
BNYCVP01.C61 0000216797 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Access the Pages Configuration screen from the Device Master main display, as shown in Fig-
ure 33: Displaying the System Configuration Screen, page 41 . The Pages sub-menu (Figure 39,
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page 57) allows an authorized operator to select which of the nine available data fields will be
displayed on the Cake page. Select each field to be displayed as shown in Figure 40, page 57.
Figure 39. Typical Pages Configuration

The Cake Page displays the selected data for the goods on each device, as specified by the Pages
configuration.
Figure 40. Cake Page Display
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4 Hardware

BNYCVF09 / 2019033 BNYCVF09 0000216844 A.5 1/2/20, 2:22 PM Released

4.1 Component Descriptions
BNYCVF09.C01 0000216843 B.2 A.4 A.5 1/2/20, 2:22 PM Released

Table 8. Objective and Supported Communication Protocols

Device Name Objective

Protocol for
Loading

(Receiving)

Protocol for Un-
loading

(Discharging)

Dryer Unloader receives and stores goods discharged
from one or more Milnor® dryers Miltrac™ Miltrac™ or allied

Storage Belt receives and stores goods discharged
from a Milnor® device Miltrac™ Miltrac™ or allied

Non-storage Belt receives, but does not store, goods dis-
charged from a Milnor® device Miltrac™ Miltrac™ or allied

Allied Dryer provides a Miltrac™ interface for a non-
Milnor® dryer Miltrac™ or allied Miltrac™ or allied

Allied Hand Loader a manually loaded device which dis-
charges to a Milnor® device Operator Miltrac™

Feeder Belt
receives and stores goods discharged
from a Milnor® device for manual
unloading

Miltrac™ Operator

Sequencing Belt
receives and stores goods discharged
from a Device Master device for manual
unloading

Miltrac™ Operator

Linear Costa
receives and stores up to eight separate
cakes from a Milnor® or non-Milnor®
device

Miltrac™ or allied Miltrac™ or allied

Table 9. Run Direction and Photoeyes

Device Name
Runs One or Two

Directions
Load End
Photoeye

Discharge End
Photoeye

Additional
Photoeyes

Dryer Unloader Two directions Yes Yes No
Storage Belt One direction Yes Yes No

Non-storage Belt Two directions No No No
Dryer Handler n/a No No No

Allied Hand Loader One direction No Yes No
Feeder Belt One direction Yes Yes No
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Table 9 Run Direction and Photoeyes (cont'd.)

Device Name
Runs One or Two

Directions
Load End
Photoeye

Discharge End
Photoeye

Additional
Photoeyes

Sequencing Belt One direction Yes Yes Yes
Linear Costa Two directions Yes Yes No

Table 10. Allied Communication and Associated Belts

Device Name
Passes Allied
Batch Data

Passes Allied
Weight Data

Compatible with
Sequencing Belt

Optional Extend-
able Belt

Optional Com-
pacting Belt

Dryer Unloader Yes Yes Yes Yes No
Storage Belt Yes Yes No Yes Yes

Non-storage Belt Yes Yes Yes Yes No
Dryer Handler Yes Yes No No No

Allied Hand Loader No No No No Yes
Feeder Belt No No No No No

Sequencing Belt No No No No No
Linear Costa Yes Yes No No No

BNYCVF10 / 2019052 BNYCVF10 0000217268 A.8 1/2/20, 2:22 PM Released

4.2 Hardware Requirements
BNYCVF10.C01 0000217284 A.3 B.2 A.8 1/2/20, 2:22 PM Released

4.2.1 System Requirements
BNYCVF10.C02 0000217283 B.2 A.4 A.8 1/2/20, 2:22 PM Released

All Devices Every Device Master controller system must have one 8-output/16-input board at
address 01h. Refer to Section 6.1.4 : Assigning Board Addresses, page 104.

NOTICE: In any Device Master system, containing up to 16 devices, only one board is
allowed at any address. For example, if a Device Master system comprises five devices,
there will be one board at address 01h. There may be additional boards, but each will oc-
cupy a unique address.

4.2.2 Additional Requirements for Certain Devices
BNYCVF10.C03 0000217282 B.2 A.4 A.8 1/2/20, 2:22 PM Released

1. A Device Master controller which is configured for one to 16 devices requires one 8-output/
16-input board set to address 02h if at least one device numbered 0 through 3 is configured as
a belt (Dryer Unloader, Storage, Non-storage, Feeder, Linear Costa, or Sequencing).

2. A Device Master controller which is configured for five to 16 devices requires one 8-output/
16-input board set to address 03h if at least one device numbered 4 through 7 is configured as
a belt (Dryer Unloader, Storage, Non-storage, Feeder, Linear Costa, or Sequencing).

3. A Device Master controller which is configured from one to 16 devices always requires one
8-output/16-input board set to address 04h.
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4. A Device Master controller which is configured from nine to 16 devices requires one 8-out-
put/16-input board set to address 81h if at least one device numbered 8 through 11 is config-
ured as a Dryer Unloader, Storage, Non-storage, or Linear Costa belt, and configured for
allied discharge, or if device 13 or 14 is configured as a Sequencer.

5. A Device Master controller which is configured from nine to 16 devices requires one 8-out-
put/16-input board set to address 82h if at least one device numbered 8 through 11, is config-
ured as a belt (Dryer Unloader, Storage, Non-storage, Feeder, Sequencer, or Linear Costa).

6. A Device Master controller which is configured from 13 to 16 devices requires one 8-output/
16-input board set to address 83h if at least one device numbered 12 through 15 is configured
as a belt (Dryer Unloader, Storage, Non-storage, Feeder, Sequencer, or Linear Costa).

7. A Device Master controller which is configured from nine to 16 devices always requires one
8-output/16-input board set to address 84h.

8. Each Device Master-controlled device which is configured as an Allied Dryer or as an Allied
Hand Loader requires a separate 8-output/16-input board. The specific address of this board
depends on its device number in the Device Master system, as shown in Table 11, page 60.

9. Each Device Master-controlled device which is configured as a Linear Costa with allied inter-
face requires two separate 8-output/16-input board. The specific address of these boards de-
pends on the device number in the Device Master system, as shown in Table 12, page 60.

Table 11. Addresses for Allied Dryer and Allied Hand Loader Devices

Device Type
Device Number

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
Allied Dryer

06h 07h 08h 09h 0Ah 0Bh 0Ch 0Dh 86h 87h 88h 89h 8Ah 8Bh 8Ch 8DhAllied Hand
Loader

Table 12. Addresses for Linear Costa Device with Allied Interface

Device Type
Device Number

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Linear Costa
06h 07h 08h 09h 0Ah 0Bh 0Ch 0Dh 86h 87h 88h 89h 8Ah 8Bh 8Ch 8Dh
40h 41h 42h 43h 44h 45h 46h 47h C0h C1h C2h C3h C4h C5h C6h C7h

4.2.3 Requirements for Options
BNYCVF10.C04 0000217281 B.2 A.4 A.8 1/2/20, 2:22 PM Released

Allied Data Passing option One 24-output board is required for each device employing the Al-
lied Data Passing option. See Table 13, page 60 for the address of this board for each valid
device number.

Table 13. Board Addresses for Allied Data and Allied Weight Passing

Option
Device Number

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
Allied Data
Passing 12h 13h 14h 15h 16h 17h 18h 19h 92h 93h 94h 95h 96h 97h 98h 99h

Allied Weight
Passing

52h 53h 54h 55h 56h 57h 58h 59h D2h D3h D4h D5h D6h D7h D8h D9h
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Allied Weight Passing option One 24-output board is required for each device employing the
Allied Weight Passing option. See Table 13, page 60 for the address of this board for each
valid device number.

Allied Weight Reading option One 8-output/16-input board is required for each device em-
ploying the Allied Weight Reading option. This option is available for Linear Costa devices
only. See Table 14, page 61 for the address of this board for each valid device number.

Table 14. Board Addresses for Allied Weight Reading

Device Type
Device Number

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
Allied Weight

Reading 48h 49h 4Ah 4Bh 4Ch 4Dh 4Eh 4Fh C8h C9h CAh CBh CCh CDh CEh CFh

Compacting Belt option One 8-output/16-input board at address 0Eh is required if one or more
devices numbered 0 through 3 are configured to use a compacting belt. One 8-output/16-input
board at adderss 0Fh is required if one or more devices numbered 4 through 7 are configured
to use a compacting belt. One 8-output/16-input board at address 8Eh is required if one or
more devices numbered 8 through 11 are configured to use a compacting belt. One 8-output/
16-input board at address 8Fh is required if one or more devices numbered 12 through 15 are
configured to use a compacting belt. This option is available on Storage belt and Allied Hand
Loader devices only.

Extendable Belt option One 8-output/16-input board at address 00h is required if one or more
devices numbered 0 through 7 are configured as an extendable belt. One 8-output/16-input
board at address 80h is required if one or more devices numbered 8 through 15 are configured
as an extendable belt. This option is available on Dryer Unloader, Storage belt and Non-stor-
age belt devices only.

Flag option A Device Master controller configured for the Flag option requires one 8-output/
16-input board set to address 05h for devices numbered 0 through 7, and a second 8-output/
16-input board set to address 85h for devices numbered 8 through 15. This board is not re-
quired for the Allied Hand Loader device, which provides its own Flag Down signal as a
standard output.

Signal Belt Transfer Status option This option is configured on the Configure/System screen
and applies only to Dryer Unloader, Storage belt, and Non-storage belt devices. One 24-out-
put board at address 1Ah for devices numbered 0 through 7, and a second 24-output board at
address 9Ah for devices numbered 8 through 15, is required if this option is enabled.

Signal option This option includes the Load Waiting signal and the Goods Different from
Last signal. One 24-output board at address 11h for devices numbered 0 through 7, and a sec-
ond 24-output board at address 91h for devices numbered 8 through 15, is required if the De-
vice Master system is configured for the Signal option. This option is configured on the
Configure/System screen and applies to all devices except Allied Hand Loader and Linear
Costa.
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4.2.4 Quick Reference Tables
BNYCVF10.R01 0000217315 B.2 A.6 A.8 1/2/20, 2:22 PM Released

Table 15. Features by Hardware Address
Board Address Implementation
01h all devices
02h Dryer Unloader, Storage Belt, Non-storage Belt, Feeder Belt, Sequencing

Belt, or Linear Costa with device number 0 through 3
03h Dryer Unloader, Storage Belt, Non-storage Belt, Feeder Belt, Sequencing

Belt, or Linear Costa with device number 4 through 7
04h All devices numbered 0 through 7
05h Flag option for devices numbered 0 through 7
06h through 0Dh Allied Dryer, Allied Hand Loader, or Linear Costa with allied interface, for

devices numbered 0 through 7
11h Signal option (Load Waiting and Goods Different) for devices numbered 0

through 7
12h through 19h Allied Data Pass option for devices numbered 0 through 7
1Ah Signal Belt Transfer Status option (Finished Discharging) for device num-

bers 0 through 7
0Eh Compacting Belt option on device number 0 through 3
0Fh Compacting Belt option on device number 4 through 7
52h through 59h Allied Weight Passing option for device numbers 0 through 7
40h through 47h Linear Costa with allied interface for device numbers 0 through 7
48h through 4Fh Allied Weight Reading option for device number 0 through 7
00h Extendable Belt option for device number 0 through 7
81h Dryer Unloader, Storage Belt, Non-storage Belt, or Linear Costa with device

number 8 through 11 and allied discharge, or Sequencing belt with device
number 13 or 14

82h Dryer Unloader, Storage Belt, Non-storage Belt, Feeder Belt, Sequencing
Belt, or Linear Costa with device number 8 through 11

83h Dryer Unloader, Storage Belt, Non-storage Belt, Feeder Belt, Sequencing
Belt, or Linear Costa with device number 12 through 15

84h All devices numbered 8 through 15
85h Flag option for device number 8 through 15
86h through 8Dh Allied Dryer, Allied Hand Loader, or Linear Costa with allied interface, for

device number 8 through 15
91h Signal option (Load Waiting and Goods Different) for device number 8

through 15
92h through 99h Allied Data Pass option for device number 8 through 15
9Ah Signal Belt Transfer Status option (Finished Discharging) for device number

8 through 15
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Table 15 Features by Hardware Address (cont'd.)
Board Address Implementation
8Eh Compacting Belt option for device number 8 through 11
8Fh Compacting Belt option for device number 12 through 15
D2h through D9h Allied Weight Passing option for device number 8 through 15
C0h through C7h Linear Costa with allied interface for device number 8 through 15
C8h through CFh Allied Weight Reading option for device number 8 through 15
80h Extendable Belt option for device number 8 through 15

Table 16, page 63 and Table 17, page 64 list the hardware addresses for the features available on
each type of device.

Table 16. Hardware Addresses for Features (Device Numbers 0 through 7)

Feature

Device Type Device Number

Notes0 1 2 3 4 5 6 7 0 1 2 3 4 5 6 7
Basic * * * * * * * * 01h
Basic * * * * * * 02h 03h
Allied
Discharge * * * * 01h 04h Discharge

Desired
Basic * * * * * * * * 04h
Flag Option * * * * * * 05h
Special
Application * * * 06h 07h 08h 09h 0Ah 0Bh 0Ch 0Dh

Compacting
Belt * * 0Eh 0Fh

Extendable
Belt * * * 00h

Signal Option
* * * * * * 11h

Load Waiting
& Goods
Different

Allied Data
Passing * * * * * 12h 13h 14h 15h 16h 17h 18h 19h Expanded

Data
Signal Belt
Transfer Status * * * 1Ah Finished

Discharging
Linear Costa
Allied * 40h 41h 42h 43h 44h 45h 46h 47h

Allied Weight
Reading * 48h 49h 4Ah 4Bh 4Ch 4Dh 4Eh 4Fh

Allied Weight
Passing * * * * * 52h 53h 54h 55h 56h 57h 58h 59h

Legend * = requires board at this address for this feature in this device type
(blank) = feature not applicable to this device type

Hardware



64 Pellerin Milnor Corporation

Table 17. Hardware Addresses for Features (Device Numbers 8 through 15)

Feature

Device Type Device Number

Notes0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
Basic * * * * * * * * 01h
Basic * * * * * * 82h 83h
Allied
Discharge * * * * 81h 84h Discharge

Desired
Basic * * * * * * * * 84h
Flag Option * * * * * * 85h
Special
Application * * * 86h 87h 88h 89h 8Ah 8Bh 8Ch 8Dh

Compacting
Belt * * 8Eh 0Fh

Extendable
Belt * * * 80h

Signal Option
* * * * * * 91h

Load Waiting
& Goods
Different

Allied Data
Passing * * * * * 92h 93h 94h 95h 96h 97h 98h 99h Expanded

Data
Signal Belt
Transfer Status * * * 9Ah Finished

Discharging
Linear Costa
Allied * C0h C1h C2h C3h C4h C5h C6h C7h

Allied Weight
Reading * C8h C9h CAh CBh CCh CDh CEh CFh

Allied Weight
Passing * * * * * D2h D3h D4h D5h D6h D7h D8h D9h

Legend * = requires board at this address for this feature in this device type
(blank) = feature not applicable to this device type
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5 Troubleshooting

BNYCVT02 / 2019033 BNYCVT02 0000216842 A.4 1/2/20, 2:22 PM Released

5.1 Error Messages
BNYCVT02.C01 0000216841 A.3 B.2 A.4 1/2/20, 2:22 PM Released

Error messages inform the user when the Device Master controller detects a problem. Device-spe-
cific errors appear only on the Cake Page or the State Page, where they can be displayed in the
appropriate device window. The system error Three Wire Disabled appears across the bottom of
the Cake Page, State Page, or the Device Master main screen. The Manual page and Inputs and
Outputs page are used to help in diagnosing input-related problems. Refer to Section 5.2 : Manual
Operation, page 67 or Section 1.4 : Viewing Electronic Inputs and Outputs, page 25 for an ex-
planation of these displays and how to use them.

5.1.1 Three-wire Disabled Error
BNYCVT02.C02 0000216840 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This system error is displayed across the bottom of the Cake Page, the State Page, or the main
page. The audible alarm sounds and the operator signal light is illuminated on the control panel.
This error indicates that the three-wire input is not made, which means that all Device Master de-
vices lost 120VAC control power. Loss of control power occurs when the Stop button is pressed
or the three-wire circuit is interrupted in any way.
To correct this error, press the Start button to re-energize the three-wire circuit. All devices con-
trolled by the Device Master controller will be initialized.

5.1.2 Device-specific Errors
BNYCVT02.C03 0000216872 A.3 B.2 A.4 1/2/20, 2:22 PM Released

The errors below may occur on individual devices controlled by Device Master, but do not affect
the system as a whole. Device-specific errors appear only in the device window on the Cake
Page or the State Page. The audible alarm sounds and the operator signal light on the control
panel is illuminated. Press the Signal Cancel button ( ) to clear the error and initialize only the
device which reported the error.

5.1.2.1 01 No Transfer
BNYCVT02.C04 0000216871 A.3 B.2 A.4 1/2/20, 2:22 PM Released

During any transfer—whether loading or discharging—this error indicates that the photoeye did
not detect a load where one was expected. Possible causes include a missing cake, a stationary
belt, or a defective photoeye or photoeye input connection.
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During a Miltrac™ transfer—loading or discharge—this error indicates that the mating device
cancelled the transfer. Look for a missing cake, a stationary belt, problems with the photoeye, or
problems with the mating device.

5.1.2.2 02 Not Reset
BNYCVT02.C05 0000216882 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies to Allied Hand Loader devices only, and indicates that the Belt Loaded and
Data Valid inputs were still made after the belt finished discharging. Check these two inputs and
the reset circuitry associated with them.

5.1.2.3 03 No Goods
BNYCVT02.C06 0000216881 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies to Allied Hand Loader devices only. It indicates that the photoeye did not detect
a load on the belt after the device received the manual Belt Loaded signal (input). Possible
causes include a missing cake, a stationary belt, or a defective photoeye or photoeye input
connection.

5.1.2.4 04 Eye Blocked
BNYCVT02.C07 0000216880 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error indicates that the photoeye was still blocked after the belt finished discharging. Look
for a blocked photoeye, a stationary belt, or a defective photoeye or photoeye input connection.

5.1.2.5 05 Transfer Aborted
BNYCVT02.C08 0000216902 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies to Linear Costa devices only, and indicates that a transfer was cancelled prior
to completion of the loading or discharging process.

5.1.2.6 06 No Cake Passed
BNYCVT02.C09 0000216901 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies to Linear Costa devices only, and indicates that the photoeye failed to detect a
cake while attempting to discharge.

5.1.2.7 07 Eye Loading Error
BNYCVT02.C10 0000216900 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies only to Linear Costa devices with the Discharge Eye Loading Error option
enabled, and indicates that the discharge end photoeye was blocked during the loading process.

5.1.2.8 08 Cake Missing
BNYCVT02.C11 0000216899 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This error applies to Linear Costa devices only, and indicates that after discharging a cake, the
photoeye failed to detect the next cake on the belt when one was expected.
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5.1.2.9 09 3-Wire Disabled
BNYCVT02.C12 0000216898 A.2 B.2 A.4 1/2/20, 2:22 PM Released

This error indicates a loss of control power to a specific device. This occurs whenever the three-
wire circuit for this device is interrupted in any way. The device initializes when the three-wire
circuit is reset.

5.1.2.10 10 Manual Mode Enabled
BNYCVT02.C13 0000216912 A.3 B.2 A.4 1/2/20, 2:22 PM Released

This message does not activate the audible alarm or operator signal, but serves to indicate when
automatic operation is suspended for a specific device. The device initializes when theManual
Mode switch is returned to the Automatic position.

BNYCVT01 / 2019033 BNYCVT01 0000215259 A.5 1/2/20, 2:22 PM Released

5.2 Manual Operation
BNYCVT01.C01 0000215258 B.2 A.4 A.5 1/2/20, 2:22 PM Released

The Device Master software allows the operator to stop automatic operation and entermanual
mode for testing and troubleshooting devices connected to the Device Master controller. With the
controller software inmanual mode, the status of individual inputs on each device can be veri-
fied through the display (see Section 5.2.4 : Monitoring Inputs, page 69), and outputs can be actu-
ated individually while the operator observes the results. Details about manual actuation of
outputs is in Section 5.2.5 : Actuating Outputs, page 70.
Display or Action Explanation

Ctrl + M stops automatic operation of the Device Master controller and ac-
cesses theManual Operation screen (see Figure 41: Manual Op-
eration Screen, page 68 ). This feature can also be accessed from
the View menu, as shown in Figure 31: Typical Inputs/Outputs
Display, page 26 .
closes theManual Operation screen and exitsManual mode to
the main Device Master screen.

Figure 41: Manual Operation Screen, page 68 shows a typicalManual Operation screen. Green
lights indicate input signals, and red buttons indicate output signals. Only those signals that apply
to the selected device are displayed; if the device is not configured for a particular option or an
option is not used, the signal name is grayed out. Positioning the mouse pointer over a valid input
or output signal displays the board address and connection information.
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Figure 41. Manual Operation Screen

5.2.1 Selecting a Device to Test
BNYCVT01.C02 0000216834 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Figure 42, page 68 shows an example of the Select Device drop-down list. Place the mouse cur-
sor over the arrow and click the left button once to display a list of all devices configured on this
controller. Highlight the desired device and click the mouse again to display the screen for the de-
vice. To view another screen, select another device from the list.
Figure 42. Select Device Region of Manual Operation Screen
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5.2.2 Direct Inputs
BNYCVT01.C03 0000216832 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Direct inputs are signals to the Device Master controller which are connected directly to the pro-
cessor board rather than a peripheral board (e.g., an 8-input/16-output board).

5.2.2.1 Program Key
BNYCVT01.C04 0000216831 A.3 B.2 A.5 1/2/20, 2:22 PM Released

The Program Key input on the Device Master processor board is permanently grounded (always
made), to facilitate changes to program memory on the processor board from the Device Master
computer.

5.2.2.2 Signal Cancel
BNYCVT01.C05 0000216830 A.3 B.2 A.5 1/2/20, 2:22 PM Released

The Signal Cancel input is made directly from the Signal Cancel button on the control panel to
the Device Master processor board; the wire from the button attaches directly to a connector on
the processor board. While there may be connectors in the wire where it passes through control
box walls, etc., there are no electronic components (relays, fuses, etc.) along the way.

5.2.3 System I/O
BNYCVT01.C06 0000216829 A.3 B.2 A.5 1/2/20, 2:22 PM Released

System inputs and outputs are general inputs and outputs that apply to the Device Master system,
rather than a particular device.

5.2.3.1 3-wire
BNYCVT01.C07 0000216828 A.3 B.2 A.5 1/2/20, 2:22 PM Released

The three-wire input is active when the three-wire circuit is energized to supply 120VAC control
power to all Device Master-controlled devices. The three-wire circuit is energized by pressing the
Start button ( ) on the operator control panel.

5.2.3.2 Signal
BNYCVT01.C08 0000216827 A.3 B.2 A.5 1/2/20, 2:22 PM Released

The signal output controls the operator alarm. When the signal output is actuated, the alarm
sounds and the signal light on the control panel illuminates.

5.2.4 Monitoring Inputs
BNYCVT01.C09 0000216826 A.3 B.2 A.5 1/2/20, 2:22 PM Released

When theManual Operation screen is displayed, all inputs that are grounded appear illumi-
nated, and all inputs that are not grounded or are not used appear dark. The I/O Legend region in
the upper right corner of theManual Operation screen shows inputs in both states.
This screen is commonly used to verify that inputs to Device Master-controlled devices are func-
tioning properly. As contacts and photoeyes are manually actuated at the remote device, the ap-
propriate light on the Device MasterManual Operation screen illuminates. For example (see
Figure 41: Manual Operation Screen, page 68 ), when the loading door of the dryer is closed, the
Load Door Closed input light is normally on.
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5.2.5 Actuating Outputs
BNYCVT01.C10 0000216845 A.3 B.2 A.5 1/2/20, 2:22 PM Released

TheManual Operation screen allows the user to turn outputs on and off while observing the sys-
tem for proper operation. Outputs that are actuated appear depressed and illuminated, while out-
puts that are turned off appear raised and dark. The I/O Legend region in the upper right corner
of theManual Operation screen shows example outputs in both states.

BNYCVT03 / 2022362 BNYCVT03 0000216935 8/29/22, 9:40 AM Released

5.3 Electronic Inputs
BNYCVT03.C01 0000216934 A.3 B.2 1/2/20, 2:22 PM Released

5.3.1 Signal Cancel, Program Key, and Direct Inputs
BNYCVT03.C02 0000216933 A.3 B.2 1/2/20, 2:22 PM Released

Table 18. Microprocessor Board Inputs
MTA Pin Device Function

MTA38

1

Direct inputs

Signal cancel
2 Program key
3 Program key
4 Direct Input #4
5 Direct Input #5
6 Direct Input #6

MTA39

3 Direct Input #9
4 Direct Input #8
5 Direct Input #7
6 Direct Input #12
7 Direct Input #11
8 Direct Input #10

5.3.2 Automatic/Manual, Sequencing Eye, and Three-wire
BNYCVT03.C03 0000216932 B.2 A.4 1/2/20, 2:22 PM Released

Table 19. 8-output/16-input Board at 01h Inputs

MTA Pin Light Number Device Function

01MTA4

1 0

not used
2 1
3 2
4 3
5 4
6 5 5 Auto/Manual
7 6 6 Auto/Manual
8 7 not used
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Table 19 8-output/16-input Board at 01h Inputs (cont'd.)

MTA Pin Light Number Device Function
11 8
12 9
13 10
14 11
15 12
16 13 5 Sequencing Eye
17 14 6 Sequencing Eye
18 15 System Three-wire

Table 20. 8-output/16-input Board at 81h Inputs

MTA Pin Light Number Device Function

81MTA4

1 0

not used
2 1
3 2
4 3
5 4
6 5 5 Auto/Manual
7 6 6 Auto/Manual
8 7

not used

11 8
12 9
13 10
14 11
15 12
16 13 5 Sequencing Eye
17 14 6 Sequencing Eye
18 15 not used

5.3.3 Photo-eyes, Loading, and Discharging
BNYCVT03.C04 0000216931 A.3 B.2 1/2/20, 2:22 PM Released

Table 21. 8-output/16-input Board at 02h Inputs

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt

02MTA4

1 0

0

Forward eye Discharge end eye
2 1 Backward eye Load end eye
3 2 Load allowed In load position
4 3 Discharge allowed In discharge position
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Table 21 8-output/16-input Board at 02h Inputs (cont'd.)

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt
5 4

1

Forward eye Discharge end eye
6 5 Backward eye Load end eye
7 6 Load allowed In load position
8 7 Discharge allowed In discharge position
11 8

2

Forward eye Discharge end eye
12 9 Backward eye Load end eye
13 10 Load allowed In load position
14 11 Discharge allowed In discharge position
15 12

3

Forward eye Discharge end eye
16 13 Backward eye Load end eye
17 14 Load allowed In load position
18 15 Discharge allowed In discharge position

Table 22. 8-output/16-input Board at 03h Inputs

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt

03MTA4

1 0

4

Forward eye Discharge end eye
2 1 Backward eye Load end eye
3 2 Load allowed In load position
4 3 Discharge allowed In discharge position
5 4

5

Forward eye Discharge end eye
6 5 Backward eye Load end eye
7 6 Load allowed In load position
8 7 Discharge allowed In discharge position
11 8

6

Forward eye Discharge end eye
12 9 Backward eye Load end eye
13 10 Load allowed In load position
14 11 Discharge allowed In discharge position
15 12

7

Forward eye Discharge end eye
16 13 Backward eye Load end eye
17 14 Load allowed In load position
18 15 Discharge allowed In discharge position
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Table 23. 8-output/16-input Board at 82h Inputs

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt

82MTA4

1 0

8

Forward eye Discharge end eye
2 1 Backward eye Load end eye
3 2 Load allowed In load position
4 3 Discharge allowed In discharge position
5 4

9

Forward eye Discharge end eye
6 5 Backward eye Load end eye
7 6 Load allowed In load position
8 7 Discharge allowed In discharge position
11 8

10

Forward eye Discharge end eye
12 9 Backward eye Load end eye
13 10 Load allowed In load position
14 11 Discharge allowed In discharge position
15 12

11

Forward eye Discharge end eye
16 13 Backward eye Load end eye
17 14 Load allowed In load position
18 15 Discharge allowed In discharge position

Table 24. 8-output/16-input Board at 83h Inputs

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt

83MTA4

1 0

12

Forward eye Discharge end eye
2 1 Backward eye Load end eye
3 2 Load allowed In load position
4 3 Discharge allowed In discharge position
5 4

13

Forward eye Discharge end eye
6 5 Backward eye Load end eye
7 6 Load allowed In load position
8 7 Discharge allowed In discharge position
11 8

14

Forward eye Discharge end eye
12 9 Backward eye Load end eye
13 10 Load allowed In load position
14 11 Discharge allowed In discharge position
15 12

15
Forward eye Discharge end eye

16 13 Backward eye Load end eye
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Table 24 8-output/16-input Board at 83h Inputs (cont'd.)

MTA Pin
Light

Number Device
Functions

Device Master Belt Linear Costa Belt
17 14 Load allowed In load position
18 15 Discharge allowed In discharge position

5.3.4 Three-wire and Manual Mode
BNYCVT03.C05 0000216930 B.2 A.4 1/2/20, 2:22 PM Released

Table 25. 8-output/16-input Board at 04h Inputs

MTA Pin Light Number Device Function

04MTA4

1 0 0

Three-wire enabled

2 1 1
3 2 2
4 3 3
5 4 4
6 5 5
7 6 6
8 7 7
11 8 0

Manual mode enabled

12 9 1
13 10 2
14 11 3
15 12 4
16 13 5
17 14 6
18 15 7

Table 26. 8-output/16-input Board at 84h Inputs

MTA Pin Light Number Device Function

84MTA4

1 0 8

Three-wire enabled

2 1 9
3 2 10
4 3 11
5 4 12
6 5 13
7 6 14
8 7 15
11 8 8

Manual mode enabled12 9 9
13 10 10
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Table 26 8-output/16-input Board at 84h Inputs (cont'd.)

MTA Pin Light Number Device Function
14 11 11
15 12 12
16 13 13
17 14 14
18 15 15

5.3.5 Unused Inputs
BNYCVT03.C06 0000216989 A.3 B.2 1/2/20, 2:22 PM Released

Table 27. 8-output/16-input Board at 05h Inputs

MTA Pin Light Number Device Function

05MTA4

1 0

Inputs on this board are not used.

2 1
3 2
4 3
5 4
6 5
7 6
8 7
11 8
12 9
13 10
14 11
15 12
16 13
17 14
18 15

Table 28. 8-output/16-input Board at 85h Inputs

MTA Pin Light Number Device Function

85MTA4

1 0

Inputs on this board are not used.

2 1
3 2
4 3
5 4
6 5
7 6
8 7
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Table 28 8-output/16-input Board at 85h Inputs (cont'd.)

MTA Pin Light Number Device Function
11 8
12 9
13 10
14 11
15 12
16 13
17 14
18 15

5.3.6 Device-specific Inputs
BNYCVT03.C07 0000216988 B.2 A.4 1/2/20, 2:22 PM Released

Table 29. Board Addresses for Dryer Handler, Allied Hand Loader, and Linear Costa Devices
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Board
Address 06h 07h 08h 09h 0Ah 0Bh 0Ch 0Dh 86h 87h 88h 89h 8Ah 8Bh 8Ch 8Dh

NOTE: Note 1: For inputs described in Table 30, page 76, the address selected for the
board must correlate to the device number for the specific device in the Device Master
system. The board address for each possible device number is shown in Table 29, page
76. In Table 30, page 76, the asterisk (*) preceding the MTA number represents the board
address.

Table 30. 8-output/16-input Board at *h for Dryer Handler, Allied Hand Loader, and Linear Costa
Devices

MTA Pin
Light

Number Device

Function
Dryer Handler Allied Hand

Loader
Linear Costa

*MTA4

1 0

See
Previous
Note

Manual mode Discharge eye Goods code bit 0
2 1 Load desired Goods code bit 1
3 2 Load door open Goods code bit 2
4 3 Load door closed Discharge allowed Goods code bit 3
5 4 Discharge desired Belt is loaded Goods code bit 4
6 5 Discharge door open Data valid Goods code bit 5

7 6 Discharge door
closed

Manual enable Goods code bit 6

8 7 Load allowed Start jog Goods code bit 7
11 8 Discharge allowed Wash code 0 Customer code bit 0
12 9 Dryer is loaded Wash code 1 Customer code bit 1
13 10 Wash code 2 Customer code bit 2
14 11 Wash code 3 Customer code bit 3
15 12 Wash code 4 Customer code bit 4
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Table 30 8-output/16-input Board at *h for Dryer Handler, Allied Hand Loader, and Linear Costa
Devices (cont'd.)

MTA Pin
Light

Number Device

Function
Dryer Handler Allied Hand

Loader
Linear Costa

16 13 Wash code 5 Customer code bit 5
17 14 Wash code 6 Customer code bit 6
18 15 Wash code 7 Customer code bit 7

5.3.7 Positioning and Compacting
BNYCVT03.C08 0000216987 A.3 B.2 1/2/20, 2:22 PM Released

Table 31. 8-output/16-input Board at 0Eh Inputs

MTA Pin
Light

Number Device Function

0EMTA4

1 0
0

Fully up
2 1 Fully down
3 2 Compacting eye
4 3 not used
5 4

1
Fully up

6 5 Fully down
7 6 Compacting eye
8 7 not used
11 8

2
Fully up

12 9 Fully down
13 10 Compacting eye
14 11 not used
15 12

3
Fully up

16 13 Fully down
17 14 Compacting eye
18 15 not used

Table 32. 8-output/16-input Board at 0Fh Inputs

MTA Pin
Light

Number Device Function

0FMTA4

1 0
4

Fully up
2 1 Fully down
3 2 Compacting eye
4 3 not used
5 4 5 Fully up

Troubleshooting



78 Pellerin Milnor Corporation

Table 32 8-output/16-input Board at 0Fh Inputs (cont'd.)

MTA Pin
Light

Number Device Function
6 5 Fully down
7 6 Compacting eye
8 7 not used
11 8

6
Fully up

12 9 Fully down
13 10 Compacting eye
14 11 not used
15 12

7
Fully up

16 13 Fully down
17 14 Compacting eye
18 15 not used

Table 33. 8-output/16-input Board at 8Eh Inputs

MTA Pin
Light

Number Device Function

8EMTA4

1 0
8

Fully up
2 1 Fully down
3 2 Compacting eye
4 3 not used
5 4

9
Fully up

6 5 Fully down
7 6 Compacting eye
8 7 not used
11 8

10
Fully up

12 9 Fully down
13 10 Compacting eye
14 11 not used
15 12

11
Fully up

16 13 Fully down
17 14 Compacting eye
18 15 not used
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Table 34. 8-output/16-input Board at 8Fh Inputs

MTA Pin
Light

Number Device Function

8FMTA4

1 0
12

Fully up
2 1 Fully down
3 2 Compacting eye
4 3 not used
5 4

13
Fully up

6 5 Fully down
7 6 Compacting eye
8 7 not used
11 8

14
Fully up

12 9 Fully down
13 10 Compacting eye
14 11 not used
15 12

15
Fully up

16 13 Fully down
17 14 Compacting eye
18 15 not used

5.3.8 Extend and Retract
BNYCVT03.C09 0000216986 B.2 A.4 1/2/20, 2:22 PM Released

Table 35. 8-output/16-input Board at 00h Inputs

MTA Pin
Light

Number Device Function

00MTA4

1 0
0

Fully extended
2 1 Fully retracted
3 2

1
Fully extended

4 3 Fully retracted
5 4

2
Fully extended

6 5 Fully retracted
7 6

3
Fully extended

8 7 Fully retracted
11 8

4
Fully extended

12 9 Fully retracted
13 10

5
Fully extended

14 11 Fully retracted
15 12 6 Fully extended
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Table 35 8-output/16-input Board at 00h Inputs (cont'd.)

MTA Pin
Light

Number Device Function
16 13 Fully retracted
17 14

7
Fully extended

18 15 Fully retracted

Table 36. 8-output/16-input Board at 80h Inputs

MTA Pin
Light

Number Device Function

80MTA4

1 0
8

Fully extended
2 1 Fully retracted
3 2

9
Fully extended

4 3 Fully retracted
5 4

10
Fully extended

6 5 Fully retracted
7 6

11
Fully extended

8 7 Fully retracted
11 8

12
Fully extended

12 9 Fully retracted
13 10

13
Fully extended

14 11 Fully retracted
15 12

14
Fully extended

16 13 Fully retracted
17 14

15
Fully extended

18 15 Fully retracted

5.3.9 Allied Interface Boards for Linear Costa Devices
BNYCVT03.C10 0000216985 B.2 8/25/22, 4:18 PM Released

Table 37. Allied Interface Board Addresses for Linear Costa Devices
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Board
Address 40h 41h 42h 43h 44h 45h 46h 47h C0h C1h C2h C3h C4h C5h C6h C7h

NOTE: For inputs described in Table 38, page 81 and Table 39, page 81, the address se-
lected for the board must correlate to the device number for the specific device in the De-
vice Master system. The board address for each possible device number is shown in Table
37, page 80. In Table 38, page 81 and Table 39, page 81, the asterisk (*) preceding the
MTA number represents the board address.
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Table 38. Linear Costa Inputs: 8-output/16-input Boards at 40h through 47h

MTA Pin
Light

Number Device Function

*MTA4

1 0

See Previous
Note

Goods code bit 0
2 1 Goods code bit 1
3 2 Goods code bit 2
4 3 Goods code bit 3
5 4 Goods code bit 4
6 5 Goods code bit 5
7 6 Goods code bit 6
8 7 Goods code bit 7
11 8 Customer code bit 0
12 9 Customer code bit 1
13 10 Customer code bit 2
14 11 Customer code bit 3
15 12 Customer code bit 4
16 13 Customer code bit 5
17 14 Customer code bit 6
18 15 Customer code bit 7

Table 39. Linear Costa Inputs: 8-output/16-input Boards at C0h through C7h

MTA Pin
Light

Number Device Function

*MTA4

1 0

See Previous
Note

Dry code bit 0
2 1 Dry code bit 1
3 2 Dry code bit 2
4 3 Dry code bit 3
5 4 Destination bit 0
6 5 Destination bit 1
7 6 Destination bit 2
8 7 Destination bit 3
11 8 Get ready to Load
12 9 Start loading
13 10 Get ready to discharge
14 11 Start discharge
15 12 Single cake
16 13 —
17 14 —
18 15 Allied transfer cancelled
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5.3.10 Weight Reading Inputs for Linear Costa Devices
BNYCVT03.C11 0000216984 B.2 A.4 1/2/20, 2:22 PM Released

Table 40. Board Addresses for Passing Weight Data to Linear Costa Devices Device Number
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Board
Address 48h 49h 4Ah 4Bh 4Ch 4Dh 4Eh 4Fh C8h C9h CAh CBh CCh CDh CEh CFh

NOTE: For inputs described in Table 41, page 82 and Table 42, page 82, the address se-
lected for the board must correlate to the device number for the specific Linear Costa de-
vice in the Device Master system. The board address for each possible device number is
shown in Table 40, page 82. In Table 41, page 82 and Table 42, page 82, the asterisk (*)
preceding the MTA number represents the board address.

Table 41. Linear Costa Weight Reading Inputs: 8-output/16-input Boards at 48h through 4Fh

MTA Pin
Light

Number Device Function

*MTA4

1 0

See Previous
Note

Weight bit 0
2 1 Weight bit 1
3 2 Weight bit 2
4 3 Weight bit 3
5 4 Weight bit 4
6 5 Weight bit 5
7 6 Weight bit 6
8 7 Weight bit 7
11 8 Weight bit 8
12 9 Weight bit 9
13 10 Weight bit 10
14 11 Weight bit 11
15 12 Weight bit 12
16 13 Weight bit 13
17 14 Weight bit 14
18 15 Weight bit 15

Table 42. Linear Costa Weight Reading Inputs: 8-output/16-input Boards at C8h through CFh

MTA Pin
Light

Number Device Function

*MTA4

1 0

See Previous
Note

Weight bit 0
2 1 Weight bit 1
3 2 Weight bit 2
4 3 Weight bit 3
5 4 Weight bit 4
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Table 42 Linear Costa Weight Reading Inputs: 8-output/16-input Boards at C8h through CFh
(cont'd.)

MTA Pin
Light

Number Device Function
6 5 Weight bit 5
7 6 Weight bit 6
8 7 Weight bit 7
11 8 Weight bit 8
12 9 Weight bit 9
13 10 Weight bit 10
14 11 Weight bit 11
15 12 Weight bit 12
16 13 Weight bit 13
17 14 Weight bit 14
18 15 Weight bit 15

BNYCVT04 / 2019052 BNYCVT04 0000217387 A.5 1/2/20, 2:22 PM Released

5.4 Electronic Outputs
BNYCVT04.C02 0000217414 A.3 B.2 A.5 1/2/20, 2:22 PM Released

5.4.1 Outputs on 8-output/16-input Boards
BNYCVT04.C01 0000217386 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Figure 43. Circuit Diagram of Outputs on 8-output/16-input Board

5.4.1.1 System Status and Discharge
BNYCVT04.C03 0000217413 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 43. 8-output/16-input Board at 01h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

01MTA5

10 19 0

all
not used

9 18 1
8 17 2 System signal
7 16 3 not used
4 14 4 0 Discharge Desired Discharge Flag Down
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Table 43 8-output/16-input Board at 01h Outputs (cont'd.)

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

3 13 5 1 Discharge Desired Discharge Flag Down
2 12 6 2 Discharge Desired Discharge Flag Down
1 11 7 3 Discharge Desired Discharge Flag Down

5.4.1.2 Run and Move Belts
BNYCVT04.C04 0000217412 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 44. 8-output/16-input Board at 02h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

02MTA5

10 19 0
0

Run forward Move belt forward
9 18 1 Run reverse Move belt rearward
8 17 2

1
Run forward Move belt forward

7 16 3 Run reverse Move belt rearward
4 14 4

2
Run forward Move belt forward

3 13 5 Run reverse Move belt rearward
2 12 6

3
Run forward Move belt forward

1 11 7 Run reverse Move belt rearward

Table 45. 8-output/16-input Board at 03h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

03MTA5

10 19 0
4

Run forward Move belt forward
9 18 1 Run reverse Move belt rearward
8 17 2

5
Run forward Move belt forward

7 16 3 Run reverse Move belt rearward
4 14 4

6
Run forward Move belt forward

3 13 5 Run reverse Move belt rearward
2 12 6

7
Run forward Move belt forward

1 11 7 Run reverse Move belt rearward

Table 46. 8-output/16-input Board at 82h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

82MTA5

10 19 0
8

Run forward Move belt forward
9 18 1 Run reverse Move belt rearward
8 17 2

9
Run forward Move belt forward

7 16 3 Run reverse Move belt rearward
4 14 4

10
Run forward Move belt forward

3 13 5 Run reverse Move belt rearward
2 12 6

11
Run forward Move belt forward

1 11 7 Run reverse Move belt rearward

Troubleshooting



Pellerin Milnor Corporation 85

Table 47. 8-output/16-input Board at 83h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

83MTA5

10 19 0
12

Run forward Move belt forward
9 18 1 Run reverse Move belt rearward
8 17 2

13
Run forward Move belt forward

7 16 3 Run reverse Move belt rearward
4 14 4

14
Run forward Move belt forward

3 13 5 Run reverse Move belt rearward
2 12 6

15
Run forward Move belt forward

1 11 7 Run reverse Move belt rearward

5.4.1.3 Discharge Desired and Flag Down
BNYCVT04.C05 0000217411 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 48. 8-output/16-input Board at 04h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

04MTA5

10 19 0 4 Discharge desired Discharge flag down
9 18 1 5 Discharge desired Discharge flag down
8 17 2 6 Discharge desired Discharge flag down
7 16 3 7 Discharge desired Discharge flag down
4 14 4

all not used
3 13 5
2 12 6
1 11 7

Table 49. 8-output/16-input Board at 05h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

05MTA5

10 19 0 0 Flag down
9 18 1 1 Flag down
8 17 2 2 Flag down
7 16 3 3 Flag down
4 14 4 4 Flag down
3 13 5 5 Flag down
2 12 6 6 Flag down
1 11 7 7 Flag down

Table 50. 8-output/16-input Board at 81h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

81MTA5
10 19 0

all not used
9 18 1
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Table 50 8-output/16-input Board at 81h Outputs (cont'd.)

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

8 17 2
7 16 3
4 14 4 8 Discharge desired Discharge flag down
3 13 5 9 Discharge desired Discharge flag down
2 12 6 10 Discharge desired Discharge flag down
1 11 7 11 Discharge desired Discharge flag down

Table 51. 8-output/16-input Board at 84h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

84MTA5

10 19 0 12 Discharge desired Discharge flag down
9 18 1 13 Discharge desired Discharge flag down
8 17 2 14 Discharge desired Discharge flag down
7 16 3 15 Discharge desired Discharge flag down
4 14 4

all not used
3 13 5
2 12 6
1 11 7

Table 52. 8-output/16-input Board at 85h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light

Device
Number Device Master Belt Linear Costa Belt

85MTA5

10 19 0 8 Flag down
9 18 1 9 Flag down
8 17 2 10 Flag down
7 16 3 11 Flag down
4 14 4 12 Flag down
3 13 5 13 Flag down
2 12 6 14 Flag down
1 11 7 15 Flag down

5.4.1.4 Device-specific Outputs
BNYCVT04.C06 0000217506 A.3 B.2 A.5 1/2/20, 2:22 PM Released

NOTE: For outputs described in Table 54, page 87, Table 55, page 87, and Table 56,
page 87, the address selected for the board must correlate to the device number for the
specific device in the Device Master system. The board address for each possible device
number is shown in Table 53, page 87. In Table 54, page 87, Table 55, page 87, and Table
56, page 87, the asterisk (*) preceding the MTA number represents the board address.
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Table 53. Board Addresses for Dryer Handler, Linear Costa, and Allied Hand Loader Devices
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Board
Address 06h 07h 08h 09h 0Ah 0Bh 0Ch 0Dh 86h 87h 88h 89h 8Ah 8Bh 8Ch 8Dh

Table 54. 8-output/16-input Board at *h Outputs for Dryer Handler

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

*MTA5

10 19 0

See pre-
vious note

Allowed to load
9 18 1 Dryer loaded
8 17 2 Allowed to discharge
7 16 3 Dry code 0
4 14 4 Dry code 1
3 13 5 Dry code 2
2 12 6 Dry code 3
1 11 7 Partial load

Table 55. 8-output/16-input Board at *h Outputs for Linear Costa Belt

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

*MTA5

10 19 0

See pre-
vious note

not used
9 18 1 Want to load
8 17 2 Ready to load
7 16 3 Finished loading
4 14 4 not used
3 13 5 Want to discharge
2 12 6 Ready to discharge
1 11 7 Finished discharging

Table 56. 8-output/16-input Board at *h Outputs for Allied Hand Loader

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

*MTA5

10 19 0

See pre-
vious note

Finished loading
9 18 1 not used
8 17 2 Run reverse
7 16 3 Run forward
4 14 4 Load desired
3 13 5 Flag down
2 12 6 not used
1 11 7 not used
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5.4.1.5 Move Up and Move Down
BNYCVT04.C07 0000217575 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 57. 8-output/16-input Board at 0Eh Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

0EMTA5

10 19 0
0

Move Up
9 18 1 Move down
8 17 2

1
Move Up

7 16 3 Move down
4 14 4

2
Move Up

3 13 5 Move down
2 12 6

3
Move Up

1 11 7 Move down

Table 58. 8-output/16-input Board at 0Fh Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

0FMTA5

10 19 0
4

Move Up
9 18 1 Move down
8 17 2

5
Move Up

7 16 3 Move down
4 14 4

6
Move Up

3 13 5 Move down
2 12 6

7
Move Up

1 11 7 Move down

Table 59. 8-output/16-input Board at 8Eh Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

8EMTA5

10 19 0
8

Move Up
9 18 1 Move down
8 17 2

9
Move Up

7 16 3 Move down
4 14 4

10
Move Up

3 13 5 Move down
2 12 6

11
Move Up

1 11 7 Move down

Table 60. 8-output/16-input Board at 8Fh Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

8FMTA5
10 19 0

12
Move Up

9 18 1 Move down
8 17 2 13 Move Up
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Table 60 8-output/16-input Board at 8Fh Outputs (cont'd.)

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

7 16 3 Move down
4 14 4

14
Move Up

3 13 5 Move down
2 12 6

15
Move Up

1 11 7 Move down

5.4.1.6 Extend Belt
BNYCVT04.C08 0000217574 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 61. 8-output/16-input Board at 00h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

00MTA5

10 19 0 0

Extend belt

9 18 1 1
8 17 2 2
7 16 3 3
4 14 4 4
3 13 5 5
2 12 6 6
1 11 7 7

Table 62. 8-output/16-input Board at 80h Outputs

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

80MTA5

10 19 0 8

Extend belt

9 18 1 9
8 17 2 10
7 16 3 11
4 14 4 12
3 13 5 13
2 12 6 14
1 11 7 15

5.4.1.7 Dry Code and Destination Code for Linear Costa
BNYCVT04.C09 0000217573 B.2 A.4 A.5 1/2/20, 2:22 PM Released

NOTE: For outputs described in Table 64, page 90, the address selected for the board
must correlate to the device number for the specific device in the Device Master system.
The board address for each possible device number is shown in Table 63, page 90. In Ta-
ble 64, page 90the asterisk (*) preceding the MTA number represents the board address.
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Table 63. Board Addresses for Dry Code and Destination Code Data for Linear Costa Devices
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Board
Address 40h 41h 42h 43h 44h 45h 46h 47h C0h C1h C2h C3h C4h C5h C6h C7h

Table 64. 8-output/16-input Board at *h Outputs for Linear Costa Devices

MTA
Common

Pin
Normally
Open Pin

Output
Light Device Function

*MTA5

10 19 0

See pre-
vious note

Dry code bit 0
9 18 1 Dry code bit 1
8 17 2 Dry code bit 2
7 16 3 Dry code bit 3
4 14 4 Destination code bit 0
3 13 5 Destination code bit 1
2 12 6 Destination code bit 2
1 11 7 Destination code bit 3

5.4.2 Outputs on 24-output Boards
BNYCVT04.C10 0000217571 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Figure 44. Circuit Diagram of Outputs on 24-Output Board

5.4.2.1 Load Waiting and Load Different
BNYCVT04.C11 0000217570 A.3 B.2 A.5 1/2/20, 2:22 PM Released

Table 65. 24-output Board at 11h Outputs
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

11MTA13

1

11MTA13

11 0
0

Load waiting
2 12 1 Load different
3 13 2

1
Load waiting

4 14 3 Load different
5 15 4

2
Load waiting

6 16 5 Load different
7 17 6

3
Load waiting

8 18 7 Load different
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Table 65 24-output Board at 11h Outputs (cont'd.)
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

9 19 8
4

Load waiting
10

11MTA14

1 9 Load different

11MTA14

11 2 10
5

Load waiting
12 3 11 Load different
4 13 12

6
Load waiting

4 14 13 Load different

10

5 14
7

Load waiting
15 15 Load different
6 16

not used

16 17
7 18
17 19
8 20
18 21
9 22
19 23

Table 66. 24-output Board at 91h Outputs
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

91MTA13

1

91MTA13

11 0
8

Load waiting
2 12 1 Load different
3 13 2

9
Load waiting

4 14 3 Load different
5 15 4

10
Load waiting

6 16 5 Load different
7 17 6

11
Load waiting

8 18 7 Load different
9 19 8

12
Load waiting

10

91MTA14

1 9 Load different

91MTA14

11 2 10
13

Load waiting
12 3 11 Load different
4 13 12

14
Load waiting

4 14 13 Load different

10

5 14
15

Load waiting
15 15 Load different
6 16

not used16 17
7 18
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Table 66 24-output Board at 91h Outputs (cont'd.)
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

17 19
8 20
18 21
9 22
19 23

5.4.2.2 Done Unloading
BNYCVT04.C12 0000217609 B.2 A.4 A.5 1/2/20, 2:22 PM Released

Table 67. 24-output Board at 1Ah Outputs
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

1AMTA13

1

1AMTA13

11 0 0 Done unloading
2 12 1 not used
3 13 2 1 Done unloading
4 14 3 not used
5 15 4 2 Done unloading
6 16 5 not used
7 17 6 3 Done unloading
8 18 7 not used
9 19 8 4 Done unloading
10

1AMTA14

1 9 not used

1AMTA14

11 2 10 5 Done unloading
12 3 11 not used
4 13 12 6 Done unloading
4 14 13 not used

10

5 14 7 Done unloading
15 15

not used

6 16
16 17
7 18
17 19
8 20
18 21
9 22
19 23

Troubleshooting



Pellerin Milnor Corporation 93

Table 68. 24-output Board at 9Ah Outputs
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

9AMTA13

1

9AMTA13

11 0 8 Done unloading
2 12 1 not used
3 13 2 9 Done unloading
4 14 3 not used
5 15 4 10 Done unloading
6 16 5 not used
7 17 6 11 Done unloading
8 18 7 not used
9 19 8 12 Done unloading
10

9AMTA14

1 9 not used

9AMTA14

11 2 10 13 Done unloading
12 3 11 not used
4 13 12 14 Done unloading
4 14 13 not used

10

5 14 15 Done unloading
15 15

not used

6 16
16 17
7 18
17 19
8 20
18 21
9 22
19 23

5.4.2.3 Allied Data and Allied Weight
BNYCVT04.C13 0000217608 B.2 A.4 A.5 1/2/20, 2:22 PM Released

NOTE: For outputs described in Table 70, page 94 and Table 71, page 94, the address
selected for the board must correlate to the device number for the specific device in the
Device Master system. The board address for each possible device number is shown in
Table 69, page 94. In Table 70, page 94 and Table 71, page 94 the asterisk (*) preceding
the MTA number represents the board address.
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Table 69. Board Addresses for Allied Data Passing and Allied Weight Passing
Device
Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Allied
Data
Passing

12h 13h 14h 15h 16h 17h 18h 19h 92h 93h 94h 95h 96h 97h 98h 99h

Allied
Weight
Passing

52h 53h 54h 55h 56h 57h 58h 59h D2h D3h D4h D5h D6h D7h D8h D9h

Table 70. 24-output Board at *h Outputs for Allied Data Passing
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

*MTA13

1

*MTA13

11 0

See pre-
vious note

Allied Data Bit0
2 12 1 Allied Data Bit1
3 13 2 Allied Data Bit2
4 14 3 Allied Data Bit3
5 15 4 Allied Data Bit4
6 16 5 Allied Data Bit5
7 17 6 Allied Data Bit6
8 18 7 Allied Data Bit7
9 19 8 Allied Data Bit8
10

*MTA14

1 9 Allied Data Bit9

*MTA14

11 2 10 Allied Data Bit10
12 3 11 Allied Data Bit11
4 13 12 Allied Data Bit12
4 14 13 Allied Data Bit13

10

5 14 Allied Data Bit14
15 15 Allied Data Bit15
6 16 Allied Data Bit16
16 17 Allied Data Bit17
7 18 Allied Data Bit18
17 19 Allied Data Bit19
8 20 Allied Data Bit20
18 21 Allied Data Bit21
9 22 Allied Data Bit22
19 23 Allied Data Bit23

Table 71. 24-output Board at *h Outputs for Allied Weight Passing
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

*MTA13
1

*MTA13
11 0

See pre-
vious note

Weight Bit0
2 12 1 Weight Bit1
3 13 2 Weight Bit2
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Table 71 24-output Board at *h Outputs for Allied Weight Passing (cont'd.)
Common MTA and

Pin
Normally Open MTA

and Pin
Output
Light Device Function

4 14 3 Weight Bit3
5 15 4 Weight Bit4
6 16 5 Weight Bit5
7 17 6 Weight Bit6
8 18 7 Weight Bit7
9 19 8 Weight Bit8
10

*MTA14

1 9 Weight Bit9

*MTA14

11 2 10 Weight Bit10
12 3 11 Weight Bit11
4 13 12 Weight Bit12
4 14 13 Weight Bit13

10

5 14 Weight Bit14
15 15 Weight Bit15
6 16
16 17
7 18
17 19
8 20
18 21
9 22
19 23
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6 Supplemental Information

BNCEUF01 / 2019065 BNCEUF01 0000217707 A.8 1/2/20, 1:12 PM Released

6.1 Hardware Components of Serial Microprocessor
Controllers

BNCEUF01.C01 0000217706 A.3 B.2 A.8 1/2/20, 1:12 PM Released

6.1.1 General
BNCEUF01.C02 0000217705 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Milnor® serial microprocessor controls are designed specifically for Milnor® machines and sys-
tems. Along with certain external electromechanical relay logic and sensing devices, they control
all machine and system functions. Not every microprocessor controller includes all the com-
ponents described in this section.

6.1.2 Microprocessor Components
BNCEUF01.C03 0000217704 A.3 B.2 A.8 1/2/20, 1:12 PM Released

NOTE: This is a list of all components for Milnor® microprocessor controllers. Not
every Milnor® microprocessor controller includes all of the following components.

6.1.2.1 Keypad or Keyboard
BNCEUF01.C04 0000217703 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Depending upon the model and type of machine, the keypad may have 12, 30, or 58 buttons. The
different keypads are not interchangeable.

6.1.2.2 Keyswitch
BNCEUF01.C05 0000217702 B.2 A.4 A.8 8/28/22, 2:22 PM Released

Selects run/program modes. The key may be removed only when the switch is set to the Run
position.

CAUTION: Prevent Unauthorized Programming — To prevent unauthorized pro-
gramming, store the programming key so that it is not available to unau-
thorized personnel. Improper programming can damage equipment and
goods.
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6.1.2.3 Display
BNCEUF01.C06 0000217701 B.2 A.4 A.8 1/2/20, 1:12 PM Released

Depending upon the type and model of machine, the display may be either liquid crystal, vacuum
fluorescent, or cathode ray tube (CRT), which is a typical computer monitor. Different types of
displays are not interchangeable.
Liquid Crystal Display This type of display is identified by dark green characters on a lighter

gray background.
Vacuum fluorescent display The bright green characters on a black background make this dis-

play highly visible. This is the most common display for Milnor® washer-extractors, textile
machines, and dryers.

Cathode ray tube (CRT) The CRT display resembles a television screen in appearance and
function. This type of display is most commonly used in Miltrac™ and Mildata® systems,
which require the display of graphics such as boxes and lines. It is also used on Milnor®
CBW® tunnel washers.

6.1.2.4 Power Supply
BNCEUF01.C07 0000217700 B.2 A.5 A.8 1/2/20, 1:12 PM Released

The power supply converts the alternating current at the control circuit voltage to direct current
voltages of 12 volts positive and negative, and 5 volts positive. One or more of these values are
adjustable, depending on the specific power supply used in each application.
• The 12 volts positive is used to power all boards other than the microprocessor board. This

value is not adjustable.
• The 12 volts negative is used by the analog to digital (A/D) board. This value is not

adjustable.
• The 5 volts output powers the microprocessor. This value is adjustable and very sensitive. For

devices using microprocessors other than the 80186, the power supply must be adjusted to
provide actual voltage of 4.95VDC to 5.10VDC at the microprocessor board. Use an accurate
digital voltmeter to measure this value. For devices with 80186 microprocessors, the power
supply voltage should be 5.10VDC at the processor board.

Awire of at least 14AWG (2.5 sq mm) must be connected between the ground points on the mi-
croprocessor and the peripheral boards. This ground wire is installed at the factory if both enclo-
sures are mounted on the same machine (e.g., washer-extractors). The ground wire must be
provided during installation if the microprocessor enclosure and its associated peripheral board
enclosures are remote from one another (e.g., dryers).
Some machines, including Milnor® dryers, employ a second identical power supply to provide
power for the peripheral boards, which are mounted in an enclosure separate from the microproc-
essor enclosure.

6.1.2.5 Central Processing Unit (CPU) Board
BNCEUF01.C08 0000217699 B.2 A.5 A.8 1/2/20, 1:12 PM Released

Also referred to as the microprocessor, the central processing unit processes data received from
the various inputs, stores information, and responds to each keypad entry with the appropriate ac-
tion. It may be mounted in an enclosure separate from its peripheral boards. The CPU board con-
tains EPROMs programmed by the Milnor® factory with fixed instructions (software) that
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determine how the machine functions. Depending upon machine model/type, the processor chip
may be one of three Intel models: the 8085, the 8088, or the 80186.
Although the EPROMs do not require battery backup, the CPU board utilizes a battery which nor-
mally provides power to retain the user-programmable memory for two to three months without
external power.

6.1.2.6 Memory Expansion Board
BNCEUF01.C09 0000217698 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Increases memory space available to the processor. This board is used with 8088 CPU boards in
some applications.

6.1.2.7 Battery
BNCEUF01.C10 0000217743 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Provides memory retention backup when power is off. The battery is mounted directly on 8085
CPU boards, and mounted separately for 8088 and 80186 CPU boards. A capacitor on the 8088
and 80186 CPU boards provides enough power to retain memory for several hours after the bat-
tery has been disconnected. Once fully charged, the battery backup is reliable for two to three
months with no power applied.

6.1.2.8 Opto-Isolator Board
BNCEUF01.C11 0000217742 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Optically isolates inputs to the microprocessor for electronic noise immunity. Opto-isolators are
incorporated into the 8088 and 80186 CPU board; thus this separate board is only required for
machines employing Intel 8085 CPUs.

6.1.2.9 Input/Output Board
BNCEUF01.C12 0000217741 B.2 A.4 A.8 1/2/20, 1:12 PM Released

The 16/8 input-output board contains 16 solid-state signal input devices and eight output relays.
The input devices are capable of faithfully conducting a low VA 12VDC ground signal to the mi-
croprocessor. The output relays are socket-mounted SPDT, 12VDC electromechanical relays with
contacts capable of faithfully conducting a maximum of 25VA at 110/120VAC (0.2 ampere or
200 milliamperes at 110/120VAC) or 12.5 VA at 24VAC (0.5 ampere or 500 milliamperes at
24VAC). The output will be either 24VAC or 110/120VAC, depending on the machine model/
type.
These outputs and their power source are intended only to drive another relay with higher contact
ratings, that in turn may drive a pump, valve, solenoid, etc., from a separate power source. Never
use these outputs to directly drive a pump, valve, or solenoid unless the maximum current re-
quired never exceeds the above values. Higher ampere or VA loads will burn out traces on the
printed circuit board or possibly overload and damage the control circuit transformer.
This board has 25 status lights. The amber light flashes when the board is communicating. Each
of the 24 remaining lights represent an input (green lights) or output (red lights) on that board,
and illuminates when the corresponding input or output is made. This board has two rotary dials
which must be adjusted to set the board's address (see Section 6.1.4 : Assigning Board Addresses,
page 104 in this document). This board also has convenient test points that can be used to test
voltage to the board.
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Standard input/output board used in all devices requiring input/output boards, except those
listed below.

High-speed input/output board used only in the following devices and configurations: E6N,
J6N, and T6N washer-extractors equipped with and configured for both variable basket speed
and electronic balancing; Milrail configured for high-speed boards, and all configurations of
the M7E centrifugal extractor.

6.1.2.10 Output Board
BNCEUF01.C13 0000217740 A.3 B.2 A.8 1/2/20, 1:12 PM Released

A 24-output board contains 24 output relays identical to those described in Section 6.1.2.9 : In-
put/Output Board, page 98.

6.1.2.11 CRT (Video Display) Board
BNCEUF01.C14 0000217739 B.2 A.5 A.8 8/28/22, 2:34 PM Released

Receives display instructions from the processor and generates the signals to the video monitor to
create the desired displays; used in controllers such as the Miltron and Miltrac™ controllers and
Device Master systems.

CAUTION: Avoid Component Damage — The CRT board can be installed back-
wards, even though the cabinet and bracketry makes this difficult, and la-
belling on the parent board states the proper orientation. Use care to orient
the board correctly, otherwise microprocessor components may be
damaged.

CBW® systems with the Mentor® controller use a standard computer video display adapter,
housed within the Mentor® computer, to transmit signals from the Mentor® computer to the video
monitor. Thus, Mentor® systems do not have a separate video display board as described here.

6.1.2.12 Resistor Boards
BNCEUF01.C15 0000217738 A.3 B.2 A.8 1/2/20, 1:12 PM Released

Although visually similar, resistor boards vary according to the application. The different types
are clearly marked with part numbers, which are mentioned in the electrical schematic diagrams
and are not interchangeable.

6.1.2.13 Temperature Probe
BNCEUF01.C16 0000217737 B.2 A.4 A.8 1/2/20, 1:12 PM Released

Thermistor temperature probes are temperature-sensitive resistors through which the resist-
ance value changes with respect to the temperature of the surrounding medium (usually bath
liquor). This type of device is used in washer-extractors, textile machines, and tunnel
washers.

6.1.2.14 8 Output/16 Input Chemical Flow Meter Board
BNCEUF01.C17 0000217736 A.3 B.2 A.8 1/2/20, 1:12 PM Released

This board is used with the metered chemical injection option on textile machines. Eight outputs
and eight counters respectively are assigned to chemical valves and chemical flow meters. Two
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of the counters are non-isolated direct inputs to the microprocessor on this board and are capable
of counting pulses of 0 to 5VDC at a frequency of up to 10kHz. The remaining six counters are
optically isolated from the peripheral board microprocessor and are capable of counting pulses
from 0 to 12VDC at a frequency up to 150 Hz.

6.1.3 Serial Communications Port
BNCEUF01.C18 0000217735 B.2 A.5 A.8 1/2/20, 1:12 PM Released

All Milnor® serial microprocessors have a serial port with a nine-pin receptacle and plug to com-
municate with other devices via one of several special serial cables. If supported by the software,
downloading and printing of data is accomplished through this port. These actions are described
in the programming section of this manual.
For more information on the various separate serial cables required for these functions, see Sec-
tion 6.2 : Construction of External Serial Link Cables, page 106, if applicable.
Table 72. Board Application by Device (Part A)

Board Name
Weight Scale Interface •
Rotation Safety • │

Chemical Flow Meter • │ │
Thermocouple Signal Conditioner • │ │ │

Steam Valve (4–20mA) • │ │ │ │
Gas Valve Resistor • │ │ │ │ │

Temperature Sensing Resistor • │ │ │ │ │ │
Opto-isolator • │ │ │ │ │ │ │

CRT • │ │ │ │ │ │ │ │
Digital to Analog • │ │ │ │ │ │ │ │ │

Analog to Digital • │ │ │ │ │ │ │ │ │ │
Output • │ │ │ │ │ │ │ │ │ │ │

Input/Output • │ │ │ │ │ │ │ │ │ │ │ │
CPU • │ │ │ │ │ │ │ │ │ │ │ │ │

│ │ │ │ │ │ │ │ │ │ │ │ │ │

Device │ │ │ │ │ │ │ │ │ │ │ │ │ │
CBW®

system*
Number 1 2 1 1 1
Note(s) + 1 9 5

Device
Master*

Number 1 2 1
Note(s) 1 1

Miltrac™* Number 1 1
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Table 72 Board Application by Device (Part A) (cont'd.)
Board Name

Weight Scale Interface •
Rotation Safety • │

Chemical Flow Meter • │ │
Thermocouple Signal Conditioner • │ │ │

Steam Valve (4–20mA) • │ │ │ │
Gas Valve Resistor • │ │ │ │ │

Temperature Sensing Resistor • │ │ │ │ │ │
Opto-isolator • │ │ │ │ │ │ │

CRT • │ │ │ │ │ │ │ │
Digital to Analog • │ │ │ │ │ │ │ │ │

Analog to Digital • │ │ │ │ │ │ │ │ │ │
Output • │ │ │ │ │ │ │ │ │ │ │

Input/Output • │ │ │ │ │ │ │ │ │ │ │ │
CPU • │ │ │ │ │ │ │ │ │ │ │ │ │

│ │ │ │ │ │ │ │ │ │ │ │ │ │

Device │ │ │ │ │ │ │ │ │ │ │ │ │ │
Note(s)

VERTSTO
Number 1 2 1
Note(s)

Linear
COSTA

Number 1 1
Note(s) 1

Link Master
Number 1
Note(s)

Textile*
Number 1 1 2 1 1 1 1
Note(s) 4 1

Notes:
* Intel 80186 central processing unit
1 Boards can be added for options
2 Used on steam dryers with temperature control, and all gas dryers
3 Used on washer-extractors with temperature option

4 Analog to digital boards vary according to application. See the descriptions of
these boards elsewhere in this section

5 Required for weighing conveyors on tunnel washing systems
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Table 72 Board Application by Device (Part A) (cont'd.)
Board Name

Weight Scale Interface •
Rotation Safety • │

Chemical Flow Meter • │ │
Thermocouple Signal Conditioner • │ │ │

Steam Valve (4–20mA) • │ │ │ │
Gas Valve Resistor • │ │ │ │ │

Temperature Sensing Resistor • │ │ │ │ │ │
Opto-isolator • │ │ │ │ │ │ │

CRT • │ │ │ │ │ │ │ │
Digital to Analog • │ │ │ │ │ │ │ │ │

Analog to Digital • │ │ │ │ │ │ │ │ │ │
Output • │ │ │ │ │ │ │ │ │ │ │

Input/Output • │ │ │ │ │ │ │ │ │ │ │ │
CPU • │ │ │ │ │ │ │ │ │ │ │ │ │

│ │ │ │ │ │ │ │ │ │ │ │ │ │

Device │ │ │ │ │ │ │ │ │ │ │ │ │ │

6 Required for reuse/cooldown and/or overhead fill tanks on tunnel washing
systems

7 Mark I washer-extractor control used Intel 8085 central processing unit
8 Notes 3 and 4 apply
9 One board required per each 8 modules (see also Notes 1, 4, 5, and 6)
10 Two boards required, plus one additional board per module
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Table 73. Board Application by Device (Part B)
Board Name

Weight Scale Interface •
Rotation Safety • │

Chemical Flow Meter • │ │
Thermocouple Signal Conditioner • │ │ │

Steam Valve (4–20mA) • │ │ │ │
Gas Valve Resistor • │ │ │ │ │

Temperature Sensing Resistor • │ │ │ │ │ │
Opto-isolator • │ │ │ │ │ │ │

CRT • │ │ │ │ │ │ │ │
Digital to Analog • │ │ │ │ │ │ │ │ │

Analog to Digital • │ │ │ │ │ │ │ │ │ │
Output • │ │ │ │ │ │ │ │ │ │ │

Input/Output • │ │ │ │ │ │ │ │ │ │ │ │
CPU • │ │ │ │ │ │ │ │ │ │ │ │ │

│ │ │ │ │ │ │ │ │ │ │ │ │ │

Device │ │ │ │ │ │ │ │ │ │ │ │ │ │

COBUC
Number 1 2
Note(s) 1 1

COSHA
Number 1 2
Note(s) 1

Dryer Number 1 2 1 1 1 1 1 1
Note(s) 4 2 2 2

Extractor
Number 1 2 1
Note(s) 1 1

Press
Number 1 2 1 1
Note(s) 1 1

W/E (Mark I) Number 1 1 1 1 1 1
Note(s) 7 1 1 8 1

W/E (Mark
II-VI)

Number 1 1 1 1 1 1
Note(s) 1 1 8 1 1

Notes:
* Intel 80186 central processing unit
1 Boards can be added for options
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Table 73 Board Application by Device (Part B) (cont'd.)
Board Name

Weight Scale Interface •
Rotation Safety • │

Chemical Flow Meter • │ │
Thermocouple Signal Conditioner • │ │ │

Steam Valve (4–20mA) • │ │ │ │
Gas Valve Resistor • │ │ │ │ │

Temperature Sensing Resistor • │ │ │ │ │ │
Opto-isolator • │ │ │ │ │ │ │

CRT • │ │ │ │ │ │ │ │
Digital to Analog • │ │ │ │ │ │ │ │ │

Analog to Digital • │ │ │ │ │ │ │ │ │ │
Output • │ │ │ │ │ │ │ │ │ │ │

Input/Output • │ │ │ │ │ │ │ │ │ │ │ │
CPU • │ │ │ │ │ │ │ │ │ │ │ │ │

│ │ │ │ │ │ │ │ │ │ │ │ │ │

Device │ │ │ │ │ │ │ │ │ │ │ │ │ │
2 Used on steam dryers with temperature control, and all gas dryers
3 Used on washer-extractors with temperature option

4 Analog to digital boards vary according to application. See the descriptions of
these boards elsewhere in this section

5 Required for weighing conveyors on tunnel washing systems

6 Required for reuse/cooldown and/or overhead fill tanks on tunnel washing
systems

7 Mark I washer-extractor control used Intel 8085 central processing unit
8 Notes 3 and 4 apply
9 One board required per each 8 modules (see also Notes 1, 4, 5, and 6)
10 Two boards required, plus one additional board per module

6.1.4 Assigning Board Addresses
BNCEUF01.C19 0000217781 B.2 A.4 A.8 1/2/20, 1:12 PM Released

The input/output board, output board, analog to digital board, and digital to analog board each
have two rotary switches which establish the address for each board. This allows each board to
communicate serially with the microprocessor in its device while sending and receiving its own
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messages. In a battery of machines, the rotary switches are identical for each identical peripheral
board in each identical machine (e.g., the first input/output board (I/O-1) in each washer-extractor
has identical rotary switch settings). When a microprocessor must communicate with a higher
level control (e.g., when all dryers communicate with the Mildata® system), the higher level con-
trol must know the address of each microprocessor. For 8088 microprocessors, the high level con-
trol knows the address of each device because that information was established during
configuration (e.g., seeMiltrac Address configure decision in the programming manual for any
device that communicates with Miltrac™).
Table 74. Rotary Switch Settings

Devices

COSHA ¬
COBUC ¬

Device Master ¬
Dryer ¬

Textile ¬
Linear COSTO ¬

One-Stage Press ¬
Two-Stage Press ¬
Extractor ¬

VERTSTO ¬
Washer-Extractor ¬

Board

Analog to Digital SW2 2* 2 2 2 2
SW1 1* 1 1 1 1

Digital to Analog SW2 3* 3 3 3
SW1 1* 1 1 1

Input/Output #1 SW2 0 0 0 0 0 0 0 0 0
SW1 1 1 1 1 1 1 1 1 1

Input/Output #2 SW2 0* 0 0* 0 0 0* 0* 0 0 0 0
SW1 2* 2 2* 2 2 2* 2* 2 2 2 2

Input/Output #3 SW2 0* 0* 0* 0* 0* 0*
SW1 3* 3* 3* 3* 3* 3*

Input/Output #4 SW2 0 0* 0* 0* 0*
SW1 4 4* 4* 4* 4*

Output #1 SW2 1 1 1 1 1 1 1*
SW1 1 1 1 1 1 1 1*

Output #2 SW2 1* 1* 1* 1 1*
SW1 2* 2* 2* 2 2*

Output #3 SW2 1 1* 1*
SW1 3 3* 3*

Notes:
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Table 74 Rotary Switch Settings (cont'd.)

Devices

COSHA ¬
COBUC ¬

Device Master ¬
Dryer ¬

Textile ¬
Linear COSTO ¬

One-Stage Press ¬
Two-Stage Press ¬
Extractor ¬

VERTSTO ¬
Washer-Extractor ¬

Board
* Optional boards

1 See schematics for rotary switch positions on tunnel washer system
devices.

BNCUUP02 / 2018303 BNCUUP02 0000196987 A.9 1/2/20, 1:30 PM Released

6.2 Construction of External Serial Link Cables
BNCUUP02.C01 0000196986 B.2 A.9 1/2/20, 1:30 PM Released

This document provides information for on-site fabrication of certain types of serial communica-
tion cables. Programmable data can be transferred between compatible machines or between a
machine and a Milnor® serial memory storage device (see related note below), using the down-
load cables described in Section 6.2.2.2 : Connecting Two or More Machines for Machine-to-ma-
chine Transfer, page 108 and Section 6.2.2.3 : Connecting a Machine to a Serial Memory Storage
Device, page 109 respectively. These cable(s) connect to the cabinet-mounted 9-pin DIN type re-
ceptacle shown in Figure 45: 9-Pin DIN Connector Pin Identification (from wire entry side of
connectors), page 107 and may be installed temporarily or permanently, as appropriate.

NOTE: The currently approved printers and printer configuration settings are provided
in Section 6.3 : Printer Requirements and Settings, page 110. A pre-assembled machine-
to-printer cable similar to the cable described here, is available from Milnor (P/N
10YMK2PNTR).
NOTE: The Milnor serial memory storage device (also known as a download box) con-
tains nonvolatile memory to hold a back-up copy of the programming and configuration
data for one machine. This data is transferred between the machine and the memory stor-
age device via the DIN receptacle on the machine. Two models are currently available:
KXMIC00507 and KXMIC00508. The already wired cable and DIN connector are in-
cluded as part of the memory storage device. Consult the Milnor Service department to
determine the correct device for a particular application.
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6.2.1 Pin Identification
BNCUUP02.C02 0000196983 A.10 B.2 A.9 8/28/22, 2:48 PM Released

Figure 45: 9-Pin DIN Connector Pin Identification (from wire entry side of connectors), page 107
illustrates the DIN receptacle (which uses male pins) and the mating plug (which uses female pin
sockets), each viewed from the wire entry side. The receptacle is normally installed and wired at
the Milnor factory. The plug and female pin sockets for customer use are provided in a bag inside
the electric box. Table 75: External Serial Link Pin Assignments, page 107 shows the function of
each pin.
Figure 45. 9-Pin DIN Connector Pin Identification (from wire entry side of connectors)

Receptacle (uses male pins) Plug (uses female pin sockets)

Legend
A...Pin numbers molded into parts
B...Heavy white lines terminated with dots indicate pins normally connected together at the Milnor factory

Table 75. External Serial Link Pin Assignments

Pin
Number Function

Receptacle Wiring (inside electri-
cal enclosure)

Wire Number Color Code
1 Serial low DLL Blue and black2
3 Serial high DLH Blue and red4
5 Clear to send (not used on these models) CTS Blue and orange
6 Electronic ground 2G Blue and white9
7 Transmit data (not used on these models) TXD Blue and orange

8 +5 volts DC (used for serial memory storage
device only) V1 Blue
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CAUTION: Risk of damage to electronic components — Pin 8 is only used to supply
+5VDC power to the download box and will damage components in both
devices if not properly connected
� Never connect pin 8 to any other pin in the connector, a printer, or an-
other machine.

6.2.2 How to Wire the Cables
BNCUUP02.C03 0000196982 B.2 A.9 1/2/20, 1:30 PM Released

Because the DIN receptacle is wired to support different functions and because the data trans-
ferred across these cables can be corrupted by electrical noise, follow these instructions carefully.

6.2.2.1 Cable Specifications
BNCUUP02.C04 0000196981 B.2 A.8 A.9 1/2/20, 1:30 PM Released

Multi-conductor shielded cable that meets the following minimum requirements must be used in
the applications covered herein. Conforming cable may be purchased from Milnor (P/N
09V300A04S) or purchased from another source:
• Jacket: 600VAC insulation
• Shielding: braided, tinned copper, minimum 85 percent coverage
• Four conductors with these specifications:

– Conductive material: Tinned copper, 20 AWG
– Insulation: 300VAC, color coded
– Preferred colors: red, black, green and white

6.2.2.2 Connecting Two or More Machines for Machine-to-machine
Transfer

BNCUUP02.C05 0000196980 B.2 A.9 1/2/20, 1:30 PM Released

Figure 46: Wiring Diagram for Cable to Connect Two or More Machines, page 109 shows how to
wire a cable to connect a bank of identical machines (the Figure 46: Wiring Diagram for Cable to
Connect Two or More Machines, page 109 example shows connections for four machines) so that
data programmed on one machine in the group can be downloaded to all other machines simulta-
neously. This cable is referred to as a daisy chain because it runs in segments from machine to
machine, connecting all machines in the group.
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Figure 46. Wiring Diagram for Cable to Connect Two or More Machines
Receptacle On Each Machine Legend

A...Receptacle on machine (with male pins). Pin functions
are as follows: 1&2. . =Serial low; 3&4. . =Serial
high; 6&9. . =Ground; 5&7. . =Not used in this
application; 8. . =Not used in this application. See
previous, related caution statement.

B...Plug on cable (with female pin sockets)
C...Connect together each segment of shield so that it has

continuity across entire daisy chain.
D...Connect together each segment of an unused conduc-

tor so that it has continuity across entire daisy chain.
E...Tie shield and spare conductor(s) on one end of daisy

chain to ground. Leave unconnected on other end of
daisy chain.

Cable Wiring

The internal connections on each receptacle (machine) between pins 1 and 2, 3 and 4, and 6 and 9
make it easier to wire the cable because it is not necessary to jumper these pins together on the ca-
ble. However, this also means that every plug on the daisy chain must be plugged into a recep-
tacle. Otherwise, the serial low, serial high, and ground conductors will not have continuity
across the entire daisy chain and some machines will not receive data.
Rules and details about downloading among machines are fully described in the programming
section of the reference manual.

6.2.2.3 Connecting a Machine to a Serial Memory Storage Device
BNCUUP02.C06 0000197240 B.2 A.9 1/2/20, 1:30 PM Released

The cable used with the serial memory storage device (download box) available from Milnor, see
related note in Section 6.2 : Construction of External Serial Link Cables, page 106, is perma-
nently attached to the storage device. Cable fabrication, as shown in Figure 47: Wiring Diagram
for Cable to Connect a Machine to a Serial Memory Storage Device, page 110 , is not required
except for replacing a damaged cable. The memory storage device is the only application in
which the power conductor (Pin 8) is used.
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Figure 47. Wiring Diagram for Cable to Connect a Machine to a Serial Memory Storage Device
Receptacle Legend

A...Receptacle on machine (with male pins). Pin functions are as follows: 1&2. .
=Serial low. This application only uses Pin 1; 3. . &4. . =Serial high. This
application only uses Pin 3; 6&9. . =Ground. This application only uses Pin
9; 5&7. . =Not used in this application; 8. . =+5VDC. Provides power to
memory storage device.

B...Plug on cable (with female pin sockets)
C...Memory storage device (front panel may be different)
D...Tie shield on this end of cable to ground. Leave unconnected on other end.

Plug and Storage Device

BNCUUI01 / 2018303 BNCUUI01 0000196633 A.6 1/2/20, 1:30 PM Released

6.3 Printer Requirements and Settings
BNCUUI01.C01 0000196632 B.2 A.6 1/2/20, 1:30 PM Released

NOTICE: Because of the many differences among printer makes and models, Milnor®
cannot ensure suitability or troubleshoot printers other than those described in this docu-
ment (or certain older approved models), with the required interface cable.

6.3.1 Cable Requirements
BNCUUI01.R01 0000196631 B.2 A.6 1/2/20, 1:30 PM Released

The printer must be connected to the printer port on the machine using the appropriate one of the
following Milnor interface cables:
Table 76. Milnor Printer Cables

Printer Cable Part Number Description

10YMK2PNTR 100-formula washer-extractor, dryer, extractor, and Miltron
(CBW®) controllers

10YCBWPNTR Non-serial Miltron (CBW) controller
08MPSERCBL Mentor® (CBW) and Mildata® controllers
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6.3.2 Configuring the Citizen GSX-190 Printer
BNCUUI01.R02 0000196630 B.2 A.6 A.7 1/2/20, 1:30 PM Released

Table 77: Required Settings for Citizen GSX-190 Printer, page 111 lists the required settings for
this printer model to work properly with Milnor equipment. To print the current settings stored in
your printer, move theMenu slide switch on the printer to the VuePrint position, then hold the
Print button for three seconds. Hold theMenu button for three seconds to enter the VuePrint
menu system to make changes.
Table 77. Required Settings for Citizen GSX-190 Printer

Menu Data Field Value Menu Data Field Value

Install 1
Ribbon Normal

Character

Slash zero Off
A.S.F. Off Character set Graphics
Emulation Epson Intl character set U.S.A.

Print Style

Font Draft Code page U.S.A.
Emphasized Off

Install 2

Tear off Off
Pitch 10 characters inch Paper out Enable
Front lock Off Auto linefeed Off

Page Layout
Line spacing 6 lines per inch Copy mode Off
Form length Letter Envelope Off
Page skip Off

Serial I/F

Baud rate 9600

Print Mode
NLQ Dir Uni-directional Parity Even
Graphic Dir Uni-directional Data bits 8 bits

Stop bits 1 bit
Protocol DTR

6.3.3 Configuring the Epson LX300 Printer
BNCUUI01.R03 0000196629 B.2 A.6 1/2/20, 1:30 PM Released

The Epson model LX300 printer was supplied by Milnor prior to March 2001 to print data from
microprocessor controllers with printing functions. When shipped from Milnor, this printer was
configured to operate correctly with Milnor equipment. If the printer is replaced or must be recon-
figured for any reason, refer to the user's guide and the following table.
Table 78. Required Settings for Epson LX300 Printer

Data Field Value Data Field Value
Character spacing 10 characters per inch Tractor Single
Shape of zero 0 Interface Serial
Skip over perforation Off Bit rate 9600 bps
Character table PC 437 Parity Even
Auto line feed Off Data length 8 bits
Page length 11 inches ETX/ACT On
Auto tear off Off
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6.3.4 Previous Printer Models
BNCUUI01.C02 0000196628 B.2 A.6 1/2/20, 1:30 PM Released

The Epson LX300 printer replaced the Epson LX-810, which replaced the Epson LX-800. For in-
formation on these older printer models, request document MSSM0251AE from the Milnor
factory.
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